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Chapter 1: Introduction

Dragon NaturallySpeaking and Dragon Medical let you talk to your computer instead
of typing. As you talk, your words are transcribed onto your screen and into your
documents or e-mail messages.

Introduction to Dragon 2
About this guide 2
Conventions used in this guide 2
What if you cannot use your mouse or keyboard? 3
What should you expect from Dragon? 3
Do you still need your keyboard and mouse? 4
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Introduction to Dragon
Dragon NaturallySpeaking and Dragon Medical let you talk to your computer instead
of typing. As you talk, your words are transcribed onto your screen and into your
documents or e-mail messages.

Talking to a computer while it types what you say is called dictating. You can
dictate, rather than type, into any program that accepts text.

You can use Dragon to:

n Compose letters, memos, and send e-mail messages--Cut and paste inside your documents

as well as revise and format text. Just think about what you want to say, and then say it into

the microphone.

n Enter data into forms or spreadsheets. (Available in Professional and higher editions)--Most

people can dictate numbers faster than they can type. Using Dragon Professional or higher

editions, you can create custom voice commands to let you move from field to field on

your form by voice.

n Dictate into Electronic Health Record (EHR) applications (with Dragon Medical

Professional and higher editions).

n Work on the Web--Search the Web, access information, and navigate Web pages by

speaking URLs and links.

n Start programs and open menus.

n Use handheld recorders to dictate while you are away from your computer. Dragon can then

transcribe what you said.

About this guide
This guide covers all editions of Dragon, including Dragon NaturallySpeaking and
Dragon Medical. Most information presented applies to all the editions, and
differences between the editions are noted.

Conventions used in this guide
n This guide contains many examples of words and phrases you can say when using Dragon.

These examples appear in italics with quotation marks, for example: "Format That Bold."

n Some procedures also include sample text for you to dictate. Sample text appears in a

different typeface, with punctuation in square brackets.

n This guide applies to the five English dialects that ship with Dragon:
n US English

n UK English

n Australian English

n Indian English

n Southeast Asian English
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US English uses US spelling, punctuation, and time and currency formats. We
recommend US English for Canadian users since this dialect formats numbers
(including times, telephone numbers, and currency) in North American formats.

All other dialects use UK spelling, punctuation, and time and currency formats
(some number settings depend on your Windows Regional Settings). Where
multiple dialects are used in dictation examples, those dialects appear in a different
font style.

You can also correct a longer phrase by saying "Correct [text] Through [text]"
(US/Canada) or "Correct [text] To [text]" (Other Dialects).

This guide uses US spelling and punctuation for consistency.

This guide also includes tips and notes to help you use the software more
effectively. Tips and notes appear like this:

Note: If you pause correctly, but Dragon still types a command as dictation, you
can force it to recognize what you say as a command by holding down the CTRL key.

With Numbers Mode on, Dragon tries to interpret everything you say as a number. If
you dictate words, the results will be unpredictable. However, you can still navigate
menus and switch between programs by voice when Numbers Mode is on.

What if you cannot use your mouse or keyboard?
If using a mouse and keyboard is not an option, see Working on your Desktop.

What should you expect from Dragon?
One reason to use Dragon is to boost your productivity. Another is to reduce the
strain using a computer puts on hands, eyes, shoulders, etc. Maybe you like the
idea of being able to lean back in your chair, put your feet up on the desk, and still
get work done.

Dragon works by using sophisticated acoustic and statistical models; it can quickly
adapt to you in various ways, becoming familiar with the sound of your voice as well
as the particular words you use in your dictations. For best results, you should
develop simple habits such as positioning your microphone consistently, dictating
punctuation, speaking clearly and evenly, pausing briefly before and after voice
commands, and taking advantage of the easy tools Dragon offers to optimize
accuracy: for instance, adding to Dragon's vocabulary your own jargon, acronyms,
phrases or words for which you want a special pronunciation or spelling. Dragon lets
you import lists of vocabulary entries all at once.

Personalizing Dragon's vocabulary is easy, and very important for productivity,
since it preempts recognition errors. (If a word you dictate is not in Dragon's
vocabulary, the software cannot transcribe it.) Properly correcting Dragon's errors
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will also help it learn. The more you use Dragon, the more opportunities the
software will have to adapt to you, both in terms of acoustics and in terms of
language.

Do you still need your keyboard and mouse?
Although you can use Dragon to do almost everything on your computer by voice,
some things are still easier to do using the mouse or keyboard.

If using a mouse and keyboard is an option for you, try experimenting with using
your voice and using your hands for different tasks, to see what works best.
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Chapter 2: What's new in
Dragon Medical 360 |

Network Edition

This chapter highlights the new features, functionality, and components that are
available in Dragon Medical 360 | Network Edition.

The chapter discusses the new features provided by Dragon Medical 360 | Network
Edition as well as the various features and components such as the Nuance
Management Console that are part of Dragon Medical 360 | Network Edition.

What's new in Dragon Medical 360 | Network Edition 6
Closing the Dragon Medical client from a command line 9
Recommended System Requirements for the Dragon Medical
client 11
Connect Dragon to a specific Nuance Management Server 13
Steps for logging in to the system from Dragon 18
Opening a user profile and saving user files 21
Deleting a user profile and sending it to Nuance for analysis 24
About multiple dictation sources 26
Using Dragon Medical Client 2.0 without a network con-
nection 27
Always display the Open Profile dialog box when Dragon Med-
ical client 2.0 starts 30
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What's new in Dragon Medical 360 |
Network Edition
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New in Dragon Medical 360 | Network Edition,
version 2.0 for Providers

Feature Description

Word Sharing As you add new words to your vocabulary
via the Dragon Medical 360 | Network Edi-
tion client, your additions automatically go
to your vocabulary in the cloud.

Access to custom words created by an
administrator

You, the end-user, can access and use cus-
tom words (written and spoken forms only)
that an NMS administrator adds to the NMS
using the NMC. You do not need to man-
ually add these words.
For details, see the Nuance Management
Server Administrator guide.

Access to the latest Dragon US med-
ical vocabularies

You have access to the latest Dragon US
medical vocabularies and can experience
the full benefits of improved medical rec-
ognition.
For details, see Choosing a Medical vocab-
ulary to support your specialty.

Custom words added through Dragon
are available in other speech appli-
cations

When you, the end-user, use Dragon to
add words to a profile, these custom words
are available when you log into other
speech applications, like Dragon Medical
360 | Direct. You do not have to enter the
words twice.
For details, see the Nuance Management
Server Administrator guide.

Hidden Dictation Box You can now display the Dictation Box at a
level of transparency that you set. This
replaces Hidden Mode from previous ver-
sions of Dragon Medical Edition. For details,
see Using the Dictation Box and Using Hid-
den Dictation BoxSee "Using Hidden Dic-
tation Box" on page

Using BestMatch V acoustic models
with large vocabularies on Windows
XP

You can use BestMatch V acoustic models
with a medium size vocabulary on Win-
dows XP. Note: Using large vocabularies
causes an out of memory error to occur.
For details, see Advanced - Choose Models.
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Feature Description

Preserve user settings during
upgrade.

When you, the end-user, add custom
words through Dragon, they will be shared
through NMS and they will be available
when you log into Dragon Medical 360 |
Direct. You do not have to enter the words
twice. For details, see the Nuance Man-
agement Server Administrator guide.

Reconnect your microphone without
needing to reload your user profile.

If you disconnect your microphone and
then reconnect it, you no longer need to
reload your user profile.
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Closing the Dragon Medical client
from a command line

In Dragon Medical 360 | Network Edition, version 2.0, on any workstation where
Dragon is installed, end-users can logout of Dragon and close the Dragon from the
command line.

Closing Dragon from a command line is the same as closing Dragon from the
Dragonbar menu and closes all Dragon related processes.

This feature is useful for customers that use Dragon in a virtual environment as it
allows administrators to close Dragon without using the Task Manager.

1. Select Start > Run... and enter cmd in the Run dialog box that pops up.
2. Switch directories to the following path:

<drive>:\Program Files\Nuance\NaturallySpeaking 12\Program

3. To close Dragon without saving user profile changes, enter the command line
shown below. This command works even if the Automatically save user files
on close option is enabled in the Nuance Management Console.

natspeak.exe /ShutDown

4. To close Dragon and save user profile changes, enter the command line shown
below. This command works even if the Automatically save user files on
close option is disabled in the Nuance Management Console.

natspeak.exe /SaveandShutDown

Notes:

n If Dragon is running and a user profile is not open, running natspeak.exe /ShutDown or

natspeak.exe /SaveandShutDown simply closes Dragon and all related processes.

n If Dragon is running and a user profile is open, running natspeak.exe /ShutDown closes

Dragon and all related processes and does not save user profile changes.

n If Dragon is running and a user profile is open, running natspeak.exe /SaveandShutDown

closes Dragon and all related processes and saves user profile changes.

Running natspeak.exe/ShutDown during General
Training
If natspeak.exe /ShutDown executes while the General training wizard is running,
Dragon displays a dialog box that asks the end-user if they want to interrupt the
training session without saving changes.
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Workaround 1

1. The Dragon end-user provides a 'Yes' response in the dialog. This closes the Gen-
eral Training wizard.

2. The Dragon end-user closes and re-starts Dragon.

Workaround 2

1. The Dragon user does not respond to the dialog box. After few seconds, Dragon
hides and re-displays the dialog box several times until the DragonBar becomes
hidden.

2. The Dragon user closes the General Training wizard.
3. The Dragon end-user closes and re-starts Dragon.
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Recommended System Requirements
for the Dragon Medical client

Bluetooth (Optional): For Bluetooth wireless microphone support,
visit http://support.nuance.com/compatibility.

CPU: 2.4 GHz Intel Dual Core or equivalent AMD processor. (SSE2 instruction set
required).

DVD-ROM: drive required for installation

Free hard disk space: 5 GB

Internet Browser: Microsoft Internet Explorer 8, 9, and 10 (free download at
www.microsoft.com)

Microphone: Nuance-approved microphone (included in purchase)
For details on Bluetooth microphones, recorders, Tablet PCs, and other hardware,
please go to support.nuance.com/compatibility/.

Operating system: A web connection is required for activation during installation.
The software checks you system for minimum requirements. If they are not met,
the software is not installed.

n Microsoft® Windows® 8, 32 bit and 64 bit

n Microsoft® Windows® 7 and higher, 32-bit and 64-bit

n Microsoft® Windows Vista® Service Pack 2, 32-bit and 64-bit

n Microsoft® Windows XP® Service Pack 3, 32-bit only

n Microsoft® Windows Server 2008, Service Pack 1, Service Pack 2, and R2, 32-bit and 64-

bit

n Microsoft® Windows 2008 R2 64 bit Service Pack 2

Processor Cache: 2 MB

RAM:

n 2 GB RAM for Microsoft® Windows XP® and Microsoft® Windows Vista®.

n 4 GB for Microsoft® Windows® 7, 32-bit and 64-bit, Microsoft® Windows® 8, 32-bit

and 64-bit, and for Windows Server 2008 64-bit.

Sound Card: Creative® Labs Sound Blaster® 16 or equivalent sound card
supporting 16-bit recording.

Supported non-EHR Applications:

n DragonPad

n WordPad

n NotePad

n Microsoft® Word 2007, 2010 (32 & 64 bit), 2013 (32 & 64 bit)

n Microsoft® Outlook® 2007, 2010, 2013
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n Microsoft® Excel® 2007, 2010, 2013

n WordPerfect® x5, x6

n Apache OpenOffice Writer 3.4

n Internet Explorer 8, 9, 10

n Rich Internet Application IE9

n Mozilla® Firefox® 8+

n Rich Internet Application Firefox® 12+

n Rich Internet Application Google Chrome 16+

n Windows Live Mail

n Mozilla® Thunderbird™ x3 and up

n Lotus Notes 8.5
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Connect Dragon to a specific Nuance
Management Server

You must set the DM360 Network Edition Client to connect to a Nuance Management
Server. You set the name of the server in the Dragon Medical client 2.0. Your
Nuance Management Console administrator provides you with the IP address or the
network name of the server.

1. Start Dragon Medical client 2.0.
2. On the Dragon Login window, click Options.

3. On the Options window, in the Address field, type the IP address or network
name of the Nuance Management Server, or click Default to accept the default
IP address or network name for the server.
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4. Click OK.

If you are experiencing problems with your user profile, you can check the Delete a
profile checkbox to have the system delete your user profile from the Nuance
Management Server and delete the local cache user profile from the client computer
and send the user profile to Nuance. This is not a default setting and will not happen
automatically. Nuance can analyze the user profile to troubleshoot the issues.

See Deleting a user profile and sending it to Nuance for analysis for more
information.

To have the Open dialog box open every time Dragon Medical client 2.0 starts, you
select Always display Open Profile dialog box. See Always display the Open
Profile dialog box when Dragon starts for more information.

Logging into Dragon Medical client 2.0
Logging into Dragon - Overview

If you have an author license, when you first open DM360 Network Edition Client and
log into your user account one of two things occur.

n If you do not have an existing user profile, the Dragon Medical client 2.0 displays the New

User wizard to let you create a new user profile.

n If you have an existing user profile, and the Always display Open Profile dialog option

in the Options tab of the login dialog is selected, the Dragon Medical client 2.0 displays the

Open Profile dialog box that you can use to select your user profile.

If you have added additional vocabularies or dictation sources to your user profile,
the Open Profile dialog box displays all the different instances of your user profile.
To begin using the Dragon Medical client 2.0, choose an instance of your user profile
from the dialog box.

An administrator can set an option on the Nuance Management Console to delete
the local cache on the client computer when the Dragon Medical client 2.0 closes.
This option is not enabled by default. If the option is enabled, your local cache is
removed from the client computer after you close the Dragon Medical client 2.0. If
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the local cache is deleted, the Dragon client must download the user profile again
from the network, the next time it connects to the Nuance Management Console.

See Steps for logging into the system from Dragon Medical 2.0 client for steps for
logging into the Dragon Medical client 2.0.

On the client computer that hosts Dragon Medical client 2.0, you need to log into a
Windows account with read, write, and modify access to the master user profile
directory. See Using a Windows account with access to the master user profile
directory for more information.

NOTE

After your user account or the Dragon client is upgraded to Nuance Management
Server (NMS) in the cloud, you must log into the system using the Dragon client in
connected mode. This action authenticates you with the NMS and allows you to later
use Dragon in disconnected mode. You cannot use Dragon in disconnected mode
until you first login to Dragon in connected mode.

When Dragon does not display the login dialog box

If Dragon Medical client 2.0 is configured to start from a script using a Windows user
account to login, Dragon does not display the Dragon Login dialog box. Instead, the
script automatically starts Dragon and sends the users Windows logon credentials
to the Nuance Management Server (NMS). The NMS uses the credentials to
authenticate the user. The DragonBar displays the message 'Dragon is connecting
to Active Directory'.

If the Windows login user name or password is not valid, the logon fails. If the logon
fails, Dragon displays the Dragon Login dialog box and asks the user for their
Windows user name and password (which they normally obtain from an
NMS administrator).

First login into the Dragon Medical client 2.0 without an existing user profile

The first time you log into the Dragon Medical client 2.0 with an author license,
Dragon displays a link to the end user license agreement (EULA). You must accept
this agreement before you can proceed.

After you accept the license agreement, Dragon Medical client 2.0 downloads the
default settings from the Nuance Management Server to the Dragon client. The
default settings are set by an administrator.

If you do not already have a user profile, Dragon Medical client 2.0 displays the New
User wizard to let you create and train a new user profile. See Training a user profile
for more information.

You can select the dictation source and vocabulary for the user profile.
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Once Dragon Medical client 2.0 creates the user profile, Dragon stores a local copy
of the user profile in the local cache of the computer. This is called the local cache
user profile.

First login into the Dragon Medical client 2.0 with an existing user profile

The first time you log into the Dragon Medical client 2.0 with an author license and
with an existing profile, if Dragon Medical client 2.0 has a network connection,
Dragon Medical client 2.0 downloads your user profile and user settings from the
network storage location of your Master user profile to the client computer. Dragon
stores your user profile and user settings in a local cache on the client computer.

Subsequent logins into the Dragon Medical client 2.0 with an existing user profile

The next time you log into the Dragon Medical client 2.0, Dragon looks for changes
between your local cache user profile on the client computer, and your Master user
profile on the network.

Dragon Medical client 2.0 updates the user profile with the oldest 'last saved' date
with the data from the user profile with the newest 'last saved' date. For example, if
the local cache user profile was saved four days ago, and the Master user profile
was last saved a week ago, Dragon Medical client 2.0identifies the local cache user
profile as being the newest version of the profile. Dragon updates the Master user
profile with the changes from the local cache user profile.

If no differences exist between the Master user profile and the local cache user
profile, Dragon Medical client 2.0 uses the local cache user profile.

Storage of user profiles in the Dragon Medical client 2.0

A Nuance Management Console administrator determines the storage location of
the Master user profile. The administrator sets the location of the master user
profiles in the Site settings area of the Nuance Management Console.

Every time you use the Dragon Medical client 2.0, Dragon makes changes to your
user profile. Dragon Medical client 2.0 stores these changes temporarily in the local
cache user profile on the client computer. The next time Dragon Medical client 2.0
synchronizes with the Nuance Management Server, the system removes the
changes from the local cache and propagates the changes to the Master user profile
on the network.

Automatic logout of an inactive user

An administrator can set Dragon Medical client 2.0 to automatically log out an
inactive user after a specific amount of time. Dragon Medical client 2.0 displays a
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prompt that warns users that they are about to be logged out. Users can respond to
the prompt to remain logged-in to the system.
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Steps for logging in to the system
from Dragon

To use the Dragon Medical client 2.0 with the Nuance Management Server, you must
log in to the system. You must have a valid user account to log in to the system.

On the client computer that hosts Dragon Medical client 2.0, you need to log into a
windows account with read, write, and modify access to the master user profile
directory.

See Using a windows account with access to the master user profile directory for
more information.

NOTE:

After your user account or the Dragon client is upgraded to Nuance Management
Server (NMS) in the cloud, you must log into the system using the Dragon client in
connected mode. This action authenticates you with the NMS and allows you to later
use Dragon in disconnected mode. You cannot use Dragon in disconnected mode
until you first login to Dragon in connected mode.

To log in to the system from Dragon Medical client
2.0
1. Start Dragon Medical client 2.0.
2. In the Dragon Loginwindow, in the Login Name field, enter the user ID that
your administrator provides to you. If your administrator also provided a domain
name, enter that too, using the following syntax: <Domain Name>\<User
ID>, where <Domain Name> and <User ID> are the domain name and user ID
that your administrator provided. For example, Nuance\jsmith.
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3. In the Password field, enter the password that your administrator provides to
you.

4. Click Log in.

Note: The first time you log-in through Dragon or after a major upgrade, you may
need to set the address of the Nuance Management Server. On the Dragon Login
window, click Options. In the Address field, type the IP address or network name
of the Nuance Management Server, or click Default to accept the default IP address
or network name. Click OK
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User Profiles
If you are a new user with this organization, Dragon will prompt you to create a user
profile by completing the New User Wizard immediately after you log in. If you
don't already have a user profile, this is where you create one. After that, you can
train your new profile. See Training a user profile for more information.

If you use Dragon Medical Client elsewhere, you already have a user profile that you
can import instead. To prevent the New User Wizard from launching when you log
in so you can import your existing user profile, click Options in the Dragon Login
window, then select "Always display Open Profile dialog" and click OK. After you log
in, you'll see the Open Profile dialog box where you can import your user profile.
For more details, see The Open Profile dialog box.

See "Logging into Dragon Medical client 2.0" in the Dragon Help or the Dragon
User Guide for more information on logging in to the system through the Dragon
Medical client.
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Opening a user profile and saving
user files

NOTE:

After your user account or the Dragon client is upgraded to Nuance Management
Server (NMS) in the cloud, you must log into the system using the Dragon client in
connected mode. This action authenticates you with the NMS and allows you to later
use Dragon in disconnected mode. You cannot use Dragon in disconnected mode
until you first login to Dragon in connected mode.

About your user profile
A user profile is a set of files that store acoustic information about your voice.
Dragon Medical client 2.0 uses this information to recognize what you say. User
profiles contain any changes you make to the standard vocabulary, such as
specialized words, names, acronyms, and abbreviations.

Accessing your user profile
In the Nuance Management Console, an administrator creates a user account.

n If you have an existing user profile for this organization, the administrator
associates it with your user account.

n If you have an existing user profile with another organization, you can export
it from that system and then import it into your account with this organization.
This saves you time, because you won't need to create and train a new profile.

n If you have no user profile, you'll see the New User Wizard when you log into
the Dragon Medical client 2.0, which you use to create and train a new user
profile for your account.

On the client computer that hosts Dragon Medical client 2.0, you need to log into a
Windows account with read, write, and modify access to the master user profile
directory. See Using a Windows account with access to the master user profile
directory for more information.

Multiple instances of your user profile
You can only have one user profile with Dragon Medical client 2.0. However, if you
add another vocabulary or dictation source to your profile, you may have more than
one instance of it. It's important to understand that these are not copies of your
profile, just versions of it that all have the same properties as the original but
specify different dictation sources or vocabularies.
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If you have more than one instance of your user profile, you'll see the Open Profile
dialog box when you log in, where you must select the instance you want to use
before you can proceed.

Opening a user profile
1. On the Dragon menu of the DragonBar, click Open Profile.
2. In the Open Profile dialog box, select a user profile from the list, and click Open.

If the user profile requires training, Dragon Medical client 2.0 displays a message
about the need to train the profile. See Training a user profile for more information.

Importing a user profile
Before you import a user profile, consider the following:

n You cannot import a profile if you're working offline. You must be connected to
Nuance Management Server and have access to the master profile folder.

n If you already have a user profile open, you must log out of Dragon to close it
before you can import the new one.

n You can only have one user profile at a time, which means if you already have
one for this organization, the imported profile will replace it. Consider export-
ing the existing user profile before you import the new one, if you think you
may need it later.

1. In the Open Profile dialog, click Import, then select the location of the profile
you want to import and click OK to open the Import User Profile dialog box.

2. (Optional) Select "Import the user with an alternate name" and enter the new
name in the box. This is useful if you need to distinguish this user profile from a
separate one you use elsewhere.

3. Click OK to import the profile. You'll see a message when process is complete.

Synchronizing auto-texts after importing a user profile

After you import a User Profile, to synchronize your auto-texts with the Nuance
Management Server (NMS), you must log out of the Dragon client. This does not
have to occur right after the profile import unless you want to synchronize the auto-
texts immediately after the profile import.

If the Dragon client logs you out due to a period of inactivity, your auto-texts will
still synchronize with the NMS the next time your profile is loaded.

Deleting and replacing your user profile
You can easily delete and replace your user profile. This is useful if, for example, the
data has become corrupt.

You must be connected to the Nuance Management Server and have access to the
master profile folder.
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Local vs master

You can delete just the local copy of your user profile, and leave your master profile
intact, or you can delete them both.

When you delete just the local copy of your user profile, the master profile replaces
it once you log in.

When you delete both the local and master copies of your user profile, you can
either replace them with an imported profile or create a new one.

To delete only the local copy of your user profile:

In the Dragon Loginwindow, click Options, then select "Delete my local profile
only" and click OK.

To delete all copies of your user profile and replace them with a new one:

In the Dragon Loginwindow, click Options, then select "Delete my profile and
create new" and click OK. After you log in, you'll see the New User Wizard.

To delete all copies of your user profile and replace them with an imported one:

In the Dragon Loginwindow, click Options. Select "Delete my profile and create
new" and "Always display Open Profile dialog," then click OK. After you log in, you'll
see the Open Profile dialog box where you can import your user profile. For more
details, see The Open Profile dialog box.

Saving your user files and user profile
On the Dragon menu of the DragonBar, click Save User Files. Dragon displays a
progress bar while it saves the user profile. Do not close the computer while the
progress bar is visible.

23



Dragon Medical 360 | Network Edition User Guide

Deleting a user profile and sending it
to Nuance for analysis

To have Nuance troubleshoot issues you may be experiencing with your user profile,
you can have the system delete your user profile from the Nuance Management
Server and delete the local cache user profile from the client computer. An
administrator can set the profile to be automatically sent to Nuance for
troubleshooting.

After you check the Delete a profile option and log into the system, the Nuance
Management Server automatically creates a backup copy of your user profile. The
system then deletes the user profile from the local cache and the network.

A Nuance Management Console administrator must enable an option to let the
above process occur. Also, the user profile may not be sent to Nuance immediately.
For example, the administrator may wait until a certain number of user profiles have
been 'deleted' before they send the profiles to Nuance. Contact your administrator
for more information.

The Nuance Management Server automatically performs regular backups of user
profiles.

Notes:

n After you delete the user profile, Dragon will ask you to create a new one. If you want to

restore the user profile you deleted, you must contact your administrator.

n To delete a user profile without sending it to Nuance for troubleshooting (if enabled by an

administrator), or to obtain a backup copy of a user profile, contact your administrator.
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To delete a user profile and send it to Nuance
1. Start Dragon Medical client 2.0.
2. On the Dragon Login window, click Options.

3. Select the Delete a profile option.
4. Click OK.
5. In the Dragon Login window, enter the Login Name and Password provided by
your administrator, and click the Log-in button.

25



Dragon Medical 360 | Network Edition User Guide

About multiple dictation sources
Some editions of Dragon allow you to train users with multiple dictation sources.
For example, with the same user files, you can dictate with a headset microphone,
an array microphone, or a portable recorder. This way you can keep the same
custom vocabulary and training, but use the dictation style most convenient for you
at that moment. For example, you might use a headset microphone at one
computer, an array microphone at another, and a portable recorder that you use for
transcription at a third computer. By allowing multiple dictation sources for a single
set of user files, Dragon lets you move from computer to computer regardless of the
microphone type or differences in ambient noise.

26



Chapter 2: What's new in Dragon Medical 360 | Network Edition

Using Dragon Medical Client 2.0
without a network connection

To set up and configure the DM360 Network Edition Client, your computer must
have a connection to the network. Once Dragon Medical client 2.0 is set up, you can
use Dragon when it does not have a connection to the network

To use Dragon Medical client 2.0 without a connection to the network, an
administrator must enable the "Allow disconnected mode" option for the user on the
Nuance Management Console.

The administrator should disable the "Remove local cache data after usage" option
before you work in disconnected mode. The "Remove local cache data after usage"
option deletes the local cache user profile when you close Dragon Medical client 2.0.
Contact your administrator for more information.

If you find that you cannot use your user profile when Dragon Medical client 2.0 is
not connected to the network, contact your administrator.

On the client computer that hosts Dragon Medical client 2.0, you need to log into a
Windows account with read, write, and modify access to the master user profile
directory. See Using a Windows account with access to the master user profile
directory for more information.

Logging into Dragon Medical client 2.0 after initial
setup
After you set up Dragon Medical client 2.0, if you log in to Dragon without a network
connection, Dragon Medical client 2.0 uses the user profile options from the local
cache user profile. The next time Dragon Medical client 2.0 connects to the network,
the local cache user profile synchronizes with the Master user profile on the
network.

Changing Dragon Medical client 2.0 options without
a network connection
You can change Dragon Medical client 2.0 options even if Dragon does not have a
network connection. The next time Dragon Medical client 2.0 connects to the
network, the changes you make are uploaded to the Nuance Management Server.
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Adding words without a network connection
You can add words to a vocabulary when Dragon Medical client 2.0 is not connected
to the network. The new words synchronize with the Master user profile on the
network once a network connection is established again.

Obtaining Acoustic and language model
optimization updates from the server
An administrator schedules and runs optimization for acoustic and language models.
When optimization is complete, the changes are synchronized with the user profile
stored on the computer with the Dragon Medical client 2.0.

If Dragon Medical client 2.0 does not have a connection to the network, Dragon
receives the optimization updates the next time it connects to the network.

Adding Text and Graphics Commands without a
network connection
You can add Text and Graphics Commands while the Dragon Medical Client does not
have a network connection. The changes you make propagate to the Nuance
Management Server the next time Dragon connects to the network.

Note that while the custom Text and Graphics commands that you create and save
automatically go to the Nuance Management Server in the Cloud, there are some
limitations:

n Commands shared to the cloud cannot contain lists.
n Commands shared to the cloud cannot be larger than 4 MB.
n Commands with alpha and blank characters are allowed. Digits are not
allowed.

You can save commands that contain lists or that are larger than 4 MB to your local
machine, but they will not propagate to the Management Server next time that
Dragon connects to the network.

Editing Text and Graphics Commands without a
network connection
You can edit Text and Graphics Commands while the Dragon Medical Client does not
have a network connection. The changes you make propagate to the Nuance
Management Server the next time Dragon connects to the network.
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Deleting Text and Graphics Commands without a
network connection
You can delete Text and Graphics Commands while the Dragon Medical Client does
not have a network connection. When you delete a command when you do not have
a network connection, the Dragon Medical Client displays a warning dialog,
reminding you that you are disconnected and that your change will not propagate to
the server until you connect, and renames the deleted command, prepending "Will
delete upon reconnect - " to the command name. The next time the Dragon client
connects to the network, the changes you make propagate to the Nuance
Management Server, and the renamed command is deleted.

Obtaining changes to user settings from the
Nuance Management Server
Changes that an administrator makes to user settings through the Nuance
Management Console are sent to the Dragon Medical client 2.0 the next time Dragon
connects to the network.

If a user changes settings through the Dragon Medical client 2.0, the changes will
override the settings set by an administrator. If an administrator makes changes to
those settings, the administrator's changes will override any settings the user set in
Dragon. Basically, the Dragon Medical client 2.0 applies the settings that were set
by the last person that makes changes to the settings - either the Dragon user or an
administrator for the Nuance Management Console.

Length of time you can use Dragon Medical client
2.0 without a network connection
You can use Dragon Medical client 2.0 for up to 90 days without a connection to the
Nuance Management Server as long as you have a valid license. If you try to use
Dragon Medical client 2.0 after this period, you will not be able to log into the
system. Contact your Nuance Management Console administrator if you cannot log
into the system.
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Always display the Open Profile
dialog box when Dragon Medical
client 2.0 starts

You can set the Dragon Medical client 2.0 to always display the Open Profile dialog
box when you start Dragon.

Always displaying the Open Profile dialog box lets you create a new dictation source
or vocabulary, even if you did not previously complete the Getting Started Wizard
for a user profile, or did not complete the Audio Setup Wizard for a new dictation
source.

1. Start Dragon Medical client 2.0.
2. On the Dragon Login window, click Options.

3. In the Options window, select Always display Open Profile dialog. Make sure
the Address field contains the IP address or network name of the Nuance Man-
agement Server and enter it if necessary, or click Default to accept the default
IP address or network name for the server.

4. Click OK.
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You can use the Dragon Medical client 2.0 to dictate into applications with both
standard and non-standard windows.
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Starting to Dictate
Now that you've installed the software and completed training, you're ready to
dictate your first sentence.

Starting Dragon
If Dragon NaturallySpeaking or Dragon Medical is not already running, you can start
it by:

n Double-clicking the Network Edition icon on the desktop.

n Selecting Programs > Network Edition > Network Edition from the Start menu.

n If the QuickStart option is enabled, right-clicking the QuickStart taskbar tray icon and

selecting Start Dragon. For more on using the QuickStart option, see Using QuickStart.

Note: You can start Dragon over a Remote Desktop connection (Windows XP
Professional and Windows XP Home), but interactive dictation is not supported.
Using a Remote Desktop connection, you can access the DragonBar and transcribe
dictation but you cannot use a microphone attached to the remote machine to
dictate.

Turning on the microphone
Before you can dictate, you need to turn on the microphone. You turn on the
microphone by:

n Click the microphone icon on the DragonBar. You can click this icon again to turn it off.

n Pressing the plus (+) key on the numeric keypad to turn the microphone on, and then press

it again to turn the microphone off.

n Clicking the microphone icon in the Windows task bar.

The button and the volume meter on the DragonBar change to show if the
microphone is off or on.

n Shows that the microphone is off

n Shows that the microphone is on

Note: Once the microphone is off, you cannot turn it on again by voice.
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Sleeping and waking up the microphone
To make Dragon stop listening temporarily:

n Say "Go to Sleep" or "Stop Listening.". Dragon ignores everything except the "Wake Up" or

"Listen To Me" commands.

n To reactivate the microphone, say "Wake Up" or "Listen To Me."

You can also press the numeric plus (+) key to turn on/off the microphone.

Starting to Dictate
To begin dictating, start a word processor (such as Microsoft® Word or Corel®
WordPerfect®) and begin a new document. Make sure your text insertion point is at
the start of the new document.

Notes:

n You can use the DragonPad, a simple word processor included with Dragon. To open the

DragonPad, from the Tools menu on the DragonBar, click DragonPad.

n Remember to click in the window you want to talk to before you speak.

Start talking. As you talk, text displays in the Results Box while Dragon figures out
what you said. The Results Box is a small yellow window that appears on-screen as
you dictate.

The words in the Results Box may change as the program considers different
interpretations of what it heard.

The Results Box displays a line that changes from yellow to green as you speak,
indicating the volume of your dictation.

Note: When Dragon recognizes what you said as a command, the Results Box
displays a bold blue border.

You can also anchor the Results Box permanently in one place. From the Tools menu
of the DragonBar, click Options, then click the View tab and enable the Anchor
option. Don't worry about mistakes at this point; Dragon improves as you use it.
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Using Natural Punctuation
Dragon can automatically add periods and commas at the appropriate places in your
dictation without you having to explicitly speak that punctuation. The Natural
Punctuation feature can be useful in helping you get used to dictation by focusing on
what you are saying rather than how your speech is punctuated.

Natural Punctuation inserts only periods and commas. You have to dictate other
punctuation marks. Even with Natural Punctuation turned on, you can still dictate
periods and commas. As you become more adept at dictation and want more control
over where punctuation appears, you may want to explicitly dictate all your
punctuation.

Note: You can turn Natural Punctuation on and off by voice by saying
"autopunctuation on" and "autopunctuation off" or by selecting Tools > Options
from the menu of the DragonBar and clicking Automatically add commas and
periods on the Formatting tab.

Dictating Punctuation
You can dictate punctuation at any time while you are using Dragon, even when
Natural Punctuation is enabled.

Use the following list as a guide to dictating the most common punctuation marks.
(For a complete list of punctuation, see the online help.)

To enter
Say
(US/Canada) SAY (Other Dialects)

, comma comma

. period full stop

! exclamation
point or
exclamation
mark

exclamation mark

? question mark question mark

- hyphen hyphen

: colon colon
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Starting new lines and paragraphs
While you are dictating, you can use the following commands to duplicate the action
of pressing the Enterkey once (to add a new line) or twice (to add a new
paragraph).

Say To

"New Line" Add a new line

"New Paragraph Add a new paragraph

Saying "New Paragraph" presses the enter key twice and capitalizes the next word
you dictate.

Tips for dictating text
n To erase the last thing you said, say "Scratch That."

n You can repeat "Scratch That" to undo a sequence of phrases. You cannot apply "Scratch

That" to a selection that is larger than 299 characters.

n You cannot select by voice a block of text that is larger than 299 characters.

n To undo the effects of a command, say "Undo That." If "Undo That" fails to undo an action,

try repeating the command until you completely undo the operation.

n To stop a recognition in progress (and turn the microphone off), click the small red button

inside the Results Box.

n You can change the very last phrase you spoke by saying "Bold That," "Cap That," "Correct

That,"and so on; you do not have to select the text first.

n To remove a trailing space after a word, you can say "Delete Previous Character."

n You can create a spoken form for words you prefer not to say aloud. For example, you can

create a command that types "Snookums" whenever you say "Mary's nickname."

n To clear (deselect) your last selection, say "Unselect That."

For information on correcting any mistakes,see Correcting and editing.

Using the Dictation Box
Normally you can dictate and use Dragon voice commands in any text window of
any application. However, you may occasionally find an application or a specific
window in an application where some voice commands won't work or won't work
consistently.

In these situations, you can use a special window, called the Dictation Box. You use
the Dictation Box to dictate and edit text in these non-standard windows without
the difficulties you might otherwise experience.
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To start the Dictation Box:

1. Place you cursor where you want to put the text.
2. Start the Dictation Box by either:

l Saying "Show Dictation Box"
l Select Tools > Dictation Box from the DragonBar
l Use CTRL + SHIFT + D

3. When the Dictation Box displays, you can dictate and edit text inside the Dic-
tation Box using all Dragon commands.

4. Once you are done dictating and editing the text, say or click "Transfer." The text
you dictated in the Dictation Box is transferred to the application.

For more information on using the Dictation Box with a non-standard window, see
The Dictation Box and the online Help for Dragon.

Printing and saving your dictated text
Printing

From the File menu of your word processor, use the mouse to choose Print. Or say
"Click File," pause, and say "Print." You can also simply say, "Print Document" or
"Print File" if the Natural Language Commands are enabled. See the online help for
more information.

Saving

From the File menu, choose Save. You can also say "Click File" and then say "Save."
Remember, you have to pause between the "Click File" and the "Save" commands
to have Dragon recognize them as two separate commands. If the Natural
Language Commands have been enabled, you can say "Save Document."

Getting Help
To access the online Help for Dragon, click the Help menu on the DragonBar and
choose Help Topics. Alternately, you can say "Give Me Help." You can print
individual Help topics with the Print button in the Help window. To open the online
Help links, just say their names. The links will be displayed next to the application
window and will give you examples of the most common commands that work in the
application you are currently using.

The Dragon Online Help includes the following information not found in this user
guide:

n Dictation Guidelines

n Dictating using a Portable Recorder

n Correcting Recognition Errors

n Revising Text
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n Improving Recognition Accuracy

n Working on Your Desktop

n Working in Programs

n Creating Commands with MyCommands

n Dragon Tools

"What Can I Say"?
Saying "What Can I Say?" will bring up the Sample Commands window. The Sample
Commands window displays a small selection of useful commands that Dragon
recognizes for the current context, whether it is a particular program you are using
or the Windows desktop.

To Open the Sample Command window:

1. Choose Sample Commands from the Help menu on the DragonBar or say "What
can I say."

2. The Sample Commands window opens, displaying a selection of commands next
to the window you are working in.

The contents of the Sample Commands depending on which application is active.
For example, when you switch between Microsoft Outlook and the DragonPad, the
contents of the Sample Commands window changes accordingly.

To see additional commands that are available, click Command Browser at the top
of the Sample Commands window. For more information, see the online help.
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Note: A list of Global commands (available everywhere) appears if there are no
sample commands available for a specific program.

Commands marked with an asterisk (*) are available only if your administrator sets
the Enable Natural Language Commands. Contact your administrator for more
information.

Tutorial
To start the Tutorial, choose Tutorial from the Help menu on the DragonBar. The
Tutorial includes a number of lessons covering the basics of Dragon.

Troubleshooting
If you are having problems using Dragon, or if you are getting unexpected results,
please refer to the Resolving Problems and Tips sections of the online Help for
Dragon.

The DragonBar

The DragonBar gives you access to Dragon functions and features.

Microphone button and Volume display
When the microphone is on, the Volume Display shows the sound level.

n Yellow means silence or that you are speaking too softly.

n Green means that you are speaking at a Proper level
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n Red means that you are speaking too loudly.

The Full Text Control Indicator
The DragonBar includes a Full Text Control indicator that turns green when you are
in an application or window where all of Dragon's functionality is supported. The
color green indicates that you can start to dictate with Dragon.

Normally you can dictate and use Dragon voice commands in any text window of
any application. However, you may occasionally find an application or a specific
window in an application where some voice commands won't work or won't work
consistently.

When you are in a non-standard window, the Full Text Control indicator goes out,
indicating that you may have some difficulty selecting and editing dictated text.

Also, when you start dictating into a non-standard window, the DragonBar will
display Dictating into a non-standard window.

If you have difficulty in dictating or correcting in one of these non-standard
windows, use the Dictation box.

See the online Help for Dragon for more information on using the Dictation Box.

Extras Toolbar
If present in your edition, you can click the Extras button on the far right of the
DragonBar to open the Extras toolbar. The Extras toolbar displays buttons for hand-
held recorder transcription and playing back your dictation.
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Correction

Clicking the Correction button opens the Correction menu to teach the computer
what you said. See Correcting and Editing for more information.

Transcribe

Use this button to transcribe your speech from a handheld recorder. See the online
help for more information.

Start Playback, Fast Playback, and Stop Playback

When you select text and click the Start Playback button, you hear a recording of
your dictation. A yellow arrow displays on your screen during playback, following
what you said. Click the Fast Playback button to play the recording at a faster
speed. Click the Start Playback button to return to a normal speed. Click the Stop
Playback button to stop the recorded speech playback.

Skip Back and Skip Forward

Use these buttons to skip backward or forward one utterance. To Dragon, an
utterance is a group of words said together without pausing. The Extras menu items
can be displayed in the main DragonBar. See the online help for more information.

Changing the DragonBar position

To change the position of the DragonBar, click the Network Edition icon at the far
left of the DragonBar. A menu displays that lets you move the DragonBar as follows:

Select To

Docked to Top
mode (default)

lock the DragonBar to the top of the screen

Docked to Bottom
mode

lock the DragonBar to the bottom of the
screen

Floating mode freely position the DragonBar

Cling mode make the DragonBar appear just above the
window into which you are dictating.

Tray Icon Only
mode

hide the DragonBar completely and only
display the Microphone icon in the Windows
task bar.

Note: You can also hide the DragonBar by saying "Switch to Tray Icon Only Mode."
To make a hidden DragonBar reappear, right-click on the small microphone in the
lower right corner of the screen. From the menu that appears, click Restore Previous
DragonBar Mode.
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Controlling Dragon with Voice Commands
You can operate Dragon with voice commands. For example, to show the Extras
toolbar, say "Show Extras Bar." For a list of other voice commands that control
Dragon, see Controlling the DragonBar in the online help.

Using QuickStart
The Dragon QuickStart taskbar tray icon gives you quick access to Dragon. Right-
clicking the QuickStart icon displays the QuickStart menu.

When in QuickStart mode, Dragon launches automatically at system startup time
and adds the Network Edition icon to the Windows taskbar.

To enable QuickStart

There are three ways to enable QuickStart mode:

n To set the QuickStart option, on the DragonBar, select Tools > Options >

Miscellaneous. Then select the Launch in QuickStart mode on Windows startup

option.

n By clicking the Network Edition icon in the upper left corner of the DragonBar and

selecting Tray Icon Only Mode. See Using QuickStart for more information.

n An administrator can enable the option. Contact your administrator for more information.

To shut off or permanently disable QuickStart

1. In the DragonBar menu, select Tools > Options and click the Miscellaneous
tab of the Options dialog box.

2. De-select Launch in QuickStart mode on Windows startup.

Redisplaying the DragonBar

To display the DragonBar while the product is running in QuickStart mode, right-
click on the microphone icon in the QuickStart taskbar tray and select Restore
Previous DragonBar Mode.

Temporarily disabling QuickStart

To temporarily disable QuickStart, right-click the QuickStart taskbar tray icon and
select Exit. This action closes Dragon and removes the QuickStart tray icon from
the Windows taskbar. When you re-start Windows, the QuickStart taskbar tray icon
re-displays.
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Using QuickStart

You access QuickStart by right-clicking the Dragon QuickStart taskbar tray icon.
This action displays the QuickStart menus, which reflects the menus in the
DragonBar.

Select To

File > Take any of the actions you would otherwise
take from the Dragon menu on the
DragonBar:
Turn Microphone On, Log-in, Log-out, Open
Profile, Manage Vocabularies, Open Recent
Vocabulary, Save User Files, Exit

Tools > Open any option from the Tools menu.

Words > Open any option from the Words menu.

Sound > Open any option from the Sound menu.

Help > Open any option from the Help menu.

Exit Shut down Dragon if it is currently running.
You can then re-start the QuickStart feature
by restarting Windows, as long as you have
set the option to launch in QuickStart mode
on the Miscellaneous tab.

If the QuickStart icon becomes unavailable for any reason, you can always start
Dragon from the Windows Start menu.
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You can use the Dictation Box to dictate into an application window that does not
support all of Dragon's features.

Using Hidden Dictation Box 44
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Voice Commands Supported in Hidden Dictation Box 45
Limitations of Hidden Dictation Box 45
DragonBar menus Disabled in Hidden Dictation Box 45
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Using Hidden Dictation Box
Use Hidden Dictation Boxif you need to dictate while browsing in an Electronic
Medical Record system for more patient data or (in Radiology) while manipulating
an image in a Picture Archival System-Radiology Information System. Although the
Dictation Box does not display on the screen in Hidden Dictation Box, the
recognized text goes into the Dictation Box regardless of where you click. By hiding
the Dictation Box, you leave more of your computer screen available for viewing
other applications.

When you are dictating in Hidden Dictation Box, the Full Text Control indicator on
the DragonBar now indicates whether the Dictation Box contains text or whether it
is empty. Hidden Dictation Box is available only when the Dictation Box is
unanchored (the default). To change the setting, close the User Profile and select
Tools > Administrative Settings.

NOTE

You can have only one Dictation Box open at a time.

Basics of Using Hidden Dictation Box
You can start Hidden Dictation Boxin several ways:

n Use the "Show Dictation Box" voice command.
n Use the Hidden Mode hot key (CTRL+SHIFT+T) defined in The Options dialog
box Hot keys tab.

n If the Dictation Box is open, use the "Hide Dictation Box" voice command

You can then switch to or open the application you want to work in while you are
dictating.

When you have finished dictating, place the cursor in the application window where
the text should appear and say "Transfer Text" or use the Transfer Text hot key
(CTRL+SHIFT+T) (defined in The Options dialog box Hot keys tab) to transfer the
text to the selected application.

NOTES

n By default new text that you dictate starts at the end of the existing text while
in Hidden Dictation Box. If, however, you play back the audio, and you move
the cursor elsewhere in the text, any new text that you dictate starts from the
cursor location and overwrites text to the right of the cursor.

Applications Where You Can Transfer Text
from Hidden Dictation Box
You can transfer text into any application that can receive pasted text using one of
the paste methods indicated in the Dictation Box settings Paste options section.
Nuance recommends that you test using the Dictation Box procedure with the
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application of your choice before you officially deploy the Dictation Box at your
installation.

Voice Commands Supported in Hidden Dictation
Box
A limited set of voice commands is available in Hidden Dictation Box:

n "Show Dictation Box"
n "Display text"
n "Read That"
n "Transfer text"
n Access to the Dragon Templates
n Text and Graphic commands
n Formatting Commands

Your custom commands created in the MyCommands Editor are not available in
Hidden Dictation Box.

Limitations of Hidden Dictation Box
Hidden Dictation Box does not recognize the "Rewind" voice command; however, it
does rewind the audio if you use the other tools, such as the PowerMic Rewind
button, appropriate keyboard keys, or the Playback toolbar.

You cannot use Hidden Dictation Box to dictate a command with variable fields and
navigate between those fields.

NOTE

If you say "Transfer Text" while the cursor is placed in an application that the
Dictation Box does not support or in an application that cannot receive text using
the Paste method you chose in the Dictation Box settings, the text on the Windows
clipboard will be lost. To avoid this issue, enable Keep transferred text in clipboard
when the Dictation Box is closed.

DragonBar menus Disabled in Hidden Dictation Box
In Hidden Dictation Box, several menu choices in the DragonBar become disabled:

n Tools > Command Browser…
n Tools > Add New Command…
n Tools > Transcribe Recording…
n Vocabulary > Add New Word or Phrase…
n Vocabulary > Open Vocabulary Editor…
n Vocabulary > Import List of Words or Phrases…
n Vocabulary > Export CustomWord and Phrase List…
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n Audio > Improve Recognition of Word or Phrase…
n Help > Improve My Accuracy…
n Extras tool bar > Correction…
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Desktop

This chapter describes how to control almost everything on your computer with
Dragon NaturallySpeaking or Dragon Medical voice commands.
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Working on your Desktop
This chapter describes how to control almost everything on your computer with
Dragon NaturallySpeaking or Dragon Medical voice commands.

Programs, documents, and folders
Using voice commands, you can start programs and open documents and folders
that appear in your Start menu or desktop.

You can't start Dragon by voice. However, you can have Dragon automatically start
in Sleep mode whenever you start Windows by selectingMicrophone on (asleep)
option in the Miscellaneous tab of the Options dialog box. See the online help for
more information.

Starting a program

To start a program from the Start menu, say "Start" and then the name of the
program exactly as it appears on the menu or submenu of the Start menu. You can
also say the name displayed below the icon on your desktop.

For example, to start Microsoft® Internet Explorer®, say "Start Internet Explorer."

Opening documents and folders from the Start menu

To open a document or folder from the Start menu, say "Start" and then the name of
the document or folder exactly as it appears on the menu.

For example, to open a document named sales.doc, you could say "Start Sales dot
doc." To open a document named journal.wpd, you could say

"Start journal dot w p d."

To open a document or folder from your Windows® desktop, just say "Start" and
then the name below the icon. For example, to open a folder named Projects, say
"Start Projects."

Switching between open windows
You can switch between the windows you have open by saying "Switch to" and then
say the name of the program or document window exactly as it appears in the title
bar.

48



Chapter 5: Working on your Desktop

For example, if Microsoft® Word® is running, you can switch to it by saying "Switch
to Microsoft word."

You can also switch between open windows by saying "Switch to Previous Window"
(same as pressing ALT+TAB) and "Switch to Next Window" (same as pressing
ALT+SHIFT+TAB).

Say To

Switch to Next
Window

Switch to the next application.

Switch to Previous
Window

Switch to the previous application.

Switch to Microsoft
Word

Make Microsoft® Word the active
application.

Switch to (name of
application)

Switch to the open application you say. Say
the name of the application as it appears in
the title bar of the application window.

Opening and closing menus
You can activate any menu by saying the menu name.

To open a menu

1. Open a program window (for example, Microsoft® Word) and make it active. Say
the name of the menu you want to open (for example, say "File"). If the com-
mand does not work, try saying "Click" and then the name of the menu you want
to open (for example, say "Click File").

2. In this example, the File menu should open. If the command doesn't work (for
example, if the word "click" is typed into your document), you may have paused
in the middle of the command.
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3. Say the name of a menu item to activate it (for example, say "Save").
4. To close a menu, say "Cancel."

Tip:To open the Start menu, say "Click Start" or "Click Start Menu."

Note: If commands are often typed into your document instead of recognized as
commands, you can make Dragon recognize commands only when they are
preceded by saying "Click." To do this, select the Require "Click" to select
menus and controls check box on the Commands tab of the Options dialog box.
For more information, see the online Help for Dragon.

Selecting buttons, tabs, and options
When Dragon is running, you can select any button, check box, text box, or other
dialog box option you see by saying its name. If that doesn't work, say "Click" and
then its name.

For example, to select a check box labeled Toolbar, say "Toolbar" or "Click Toolbar."
To clear the check box (deselect it), say its name again.

You can select tabs by saying the name of the tab, alone or preceded by "Click." In
the dialog box pictured, you could say "Options" or "Click Options" to select the
Options tab. You can also move between tabs by saying "Go to Next Tab" and "Go
to Previous Tab."

Note: In some programs, you may not be able to select dialog box items by saying
their names. If this happens, the following method of selecting items may work: say
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"Tab Key" repeatedly to move to the item you want, then say "Press Space Bar" to
select it.

See also Moving the mouse pointer and clicking the mouse.

Selecting icons on the desktop
You can use voice commands to select icons on the Windows® desktop.

To select an icon the desktop

1. Switch to the Windows® desktop. To do this by voice, minimize all open appli-
cations and place the mouse pointer over the desktop icon. Say "Mouse Click" to
make the desktop active.

2. Say the name of the icon (for example, "My Computer"). Dragon types the icon
name and Windows® selects it.

3. To select another icon, say "Move" and then the direction (up, down, left, right)
and number of icons (up to 20).

For example: Say "Move Right 1," "Move Down 2," or "Move Up 3."

After you select an icon, you can say "Press Enter" to start or open the program and
"Press Shift F10" to display its right-click menu (as if you had right-clicked the icon
with the mouse).

You can also use voice commands for these actions. See Marking and dragging
objects in this chapter.
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Resizing and closing Windows
To resize and close windows, say "Click" and then one of the following window
commands:

Say To

Click Minimize or

Click Control Menu
(pause)Minimize

Minimize the active window.

Click Maximize or

Click Control Menu
(pause)Maximize

Maximize the active window.

Click Restore or

Click Control Menu
(pause)Restore

Restore window to previous size.

Click Close or

Press ALT F4

Close the active program.

Press CTRL F4 Close the active document, not the whole
program (works in many programs).

Click Start Menu or

Click Start or

Press CTRL ESC

Open the Windows® Start Menu.

Tip:"Click" is required for the Control menu commands.

Note: If you have trouble getting Dragon to recognize any of the window
commands, you can first open the Control menu by saying "Click Control Menu,"
then say the command.

Scrolling in windows and list boxes
You can scroll vertically in a window (for example, an online Help window) or list box
by saying "Move Down" and "Move Up" and then a number of scroll bar arrow clicks
(up to 20). For example, say "Move Down 4" or "Move Up 10."

You can scroll horizontally by saying "Move Left" and "Move Right" and then a
number of scroll bar arrow clicks (up to 20). For example, say "Move Left 10" or
"Move Right 5."
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Opening lists and making selections
You can activate any list box by saying the list box name.

To open a list box

1. Say the name of the list box you want to open.
2. Say "Show Choices," "Drop List," or "Open List." The list box opens to show all
the choices available in the list.

To make a selection from an open list

1. Say the full name of the selection.
2. Say "Move Down" or "Move Up" and the number of places your selection is from
the current selection.

Pressing keyboard keys
You can activate Windows® menus and controls by pressing keys. With Dragon you
can "press" any key on your keyboard by voice. You can press letters, numbers,
modifier keys (SHIFT, CTRL,and ALT), and so on.

You can say "Press," "Press Key," or "Type"--all three voice commands work the
same way.

Notes:

n Scratch That" will not erase keystrokes dictated with the Press Key commands. You must

select the text by voice or mouse and delete it or say "Press Delete."

n You cannot apply "Scratch That" to a selection that is larger than 299 characters.

n You cannot select by voice a block of text that is larger than 299 characters.

Pressing letters
You can press any letter on your keyboard by saying "Press" and then the letter.
When you're pressing letters, you must say "Press" before each one. For example,
to enter "txt," say "Press t," "Press x," "Press t," pausing between letters.

Note: You can also spell words using Spell mode. See Switching recognition
modes in Dictating Numbers and Punctuation for more information.

For similar-sounding letters (such as B, D, and V), you can use the International
Communications Alphabet to spell the letter keys, for example, "Press alpha" or
"Press bravo" or say "Press d as in David" or "Press d for David," and so on) as if
you were spelling to another person over the phone.

Say Then say
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Press a

b

any letter a-z or any international alphabet
word alpha through zulu

a as in Albert/Alice/alpha

b as in Bill/Buffalo/bravo

c as in Cathy/Carl/Charlie

d as in David/daughter/delta

e as in Edgar/enter/echo

f as in Frank/fancy/foxtrot

g as in George/gopher/golf

h as in Henry/helmet/hotel

i as in Iris/Ireland/India

j as in John/justice/Juliet

k as in Karen/kitchen/kilo

l as in Larry/lemon/lima

m as in Mickey/magic/Mike

n as in Nancy/nobody/November

o as in Otto/over/Oscar

p as in Paul/people/papa

q as in Quentin/question/Quebec

r as in Robert/Rachel/Romeo

s as in Sam/Singapore/sierra

t as in Terry/Tyler/tango

u as in Ursula/unit/uniform

v as in Valerie/visit/Victor

w as in Wendy/wake/whiskey

x as in Xavier/Xerxes/xray

y as in Yolanda/Yvonne/yankee

z as in Zachary/zookeeper/zulu

(you can also say "for" instead of "as in")
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Note: You can say "Press c" or "Press Charlie" but you cannot say "Press Cathy" or
"Press Carl."

Capitalizing a letter
You can capitalize a letter by saying "Press Cap," then the letter.

For example, to enter "28K" say "twenty eight" and then "Press Cap K" (or "Press
Cap K for Karen").

Pressing numbers
You can press numbers (0 to 9) by saying "Press" and then the number. For
example, say "Press 8."

Pressing key combinations
When you're pressing keys, you can press any combination of the modifier keys
(SHIFT, CTRL,and ALT) at the same time as another key, such as a letter. For
example, you can say:

n "Press Control Z" (undoes last action)

n "Press Alt F" (opens File menu)

n "Press Shift Tab" (moves backward through dialog box options)

Note: Dragon ignores the command "Press Control Alt Delete" (the keyboard
shortcut for restarting a computer).

Pressing function and numeric keypad keys

To press a function key (F1 to F12), say "Press Function" and then the name of the
key. For example, say "Press Function 1" to bring up the online Help.

To press the keys on the numeric keypad, say "Press Keypad" and then the name of
the key. For example, you can say "Press Keypad Minus" to press the keyboard
shortcut that opens the Correction menu. See the complete list below:

Say Then say

Press Keypad 1
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Keypad 9 (you can say any number from 0 to
9)

All Dialects: Keypad Point (.)

US/Canada: Keypad Period (.)

Other Dialects: Keypad Full Stop (.)

Keypad Slash (/)

Keypad Asterisk (*)

Keypad Minus (-) (opens the Correction
menu)

Keypad Plus (+) (turns the microphone on or
off)

Keypad Star (*) (opens the Dragon menu on
the DragonBar)

Keypad Enter

Note: Num Lock must be on for the "Press Keypad" commands to work. You can
say "Press Num Lock" to turn Num Lock on.

Pressing other keys
Here's a list of other keys you can press by voice:

Say Then say

Press Up Arrow

Down Arrow

Right Arrow

Left Arrow

Home Key

End Key

Page Up

Page Down

Insert Key

Delete Key
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Control Key

Shift Key

Alt Key

Print Screen

Scroll Lock

Pause Key

Num Lock

Caps Lock

Moving the mouse pointer and clicking the mouse
Dragon provides hands-free mouse control with MouseGrid and the mouse motion
voice commands. You can use these features to position the mouse pointer
anywhere on the screen, click the mouse buttons, and drag objects--all by voice.

Moving the mouse pointer with MouseGrid

You can position the mouse pointer anywhere on the screen by using MouseGrid.
You can move the pointer relative to the full screen or the active window.

To use MouseGrid

1. Say "MouseGrid" to place the MouseGrid over the full screen (as shown below) or
say "MouseGrid Window" to place it over the active window. For example:
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2. Say a grid number from 1 to 9 to position the pointer in that numbered area. In
this example, to position the pointer over the Recycle Bin, say "4." A smaller
MouseGrid will appear in the chosen grid square.
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3. To zoom in over the desired area, say another grid number. In this example, say
"4"to place the pointer over the Recycle Bin icon.

4. Continue to say the respective grid number to zoom in until the mouse pointer is
over an icon or other object. You can use voice commands to click the mouse or
mark and drag the object. See the following sections for instructions.

Notes:

n You can undo the last MouseGrid action by saying "Undo That".

n To close MouseGrid, say "Cancel."

Moving the pointer with the mouse command

You can move the mouse pointer up, down, left, or right a short distance (a few
millimeters) by using the mouse pointer commands.

You can combine moving the mouse pointer and clicking the mouse in a single voice
command. For example, you can say "Mouse Up 3 Click" or "Mouse Right 2 Double
Click."

To move the pointer

1. Say "Mouse" followed by the direction and number of times to move it (up to 10).
For example, say "Mouse Up 5" or "Mouse Left 10."

2. When the pointer is over an icon or other object, you can use voice commands to
click the mouse or mark and drag the object.
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Clicking the mouse

You can click, double-click, left-click, and right-click the mouse buttons by voice.

1. Position the mouse pointer over the object you want to select (for example, say
"MouseGrid 9 1" or "Mouse 2").

2. Say "Mouse Click," "Mouse Double Click," "Mouse Left Click," or "Mouse Right
Click."

When an object is selected, you can mark and drag the object (as described in the
next section).

Marking and dragging objects

You can mark an object and drag it to a different location by voice.

1. Position the mouse over the icon or object you want to drag and then say "Mark"
(for example, say "MouseGrid 9 1 Mark").

2. Move the mouse pointer to where you want to drag the object and then say
"Drag" (for example, say "MouseGrid 6 3 Drag").

Note: Instead of "Drag," you can also say "Control Drag" and "Shift Drag" to drag
while holding down the CTRL or SHIFT key.

Moving the pointer with the mouse motion commands

In addition to the mouse movement methods described above, you can also move
the mouse by using the mouse motion commands. Say, for example, "Move Mouse
Right." The mouse pointer begins moving to the right and keeps moving until you
say "Stop. "

Enabling the mouse motion commands

Your administrator must enable mouse motion commands. Contact your
administrator for more information.

The mouse motion commands

Here is a summary of the available mouse motion commands.

Say
Then Say a
direction

Then Say a speed
(Optional)

Move
Mouse

Mouse
Move

Drag
Mouse

Up

Down

Right

Left

Upper Left

Lower Left

Fast

Faster

Much Faster

Very Fast

Slow

Slower
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Say
Then Say a
direction

Then Say a speed
(Optional)

Mouse
Drag

Upper Right

Lower Right

Much Slower

Very Slow

While the mouse is moving, you can say any of the commands above.

You can also say:

n "Stop" or "Cancel" to stop the mouse from moving

n "Up," "Down," "Left," "Right," "Upper Left," "Lower Left," "Upper Right," or "Lower Right" to

change the direction in which the mouse is moving

n "Faster," "Much Faster," "Slower," or "Much Slower" to change the speed at which the mouse is

moving

n "Click," "Double Click," "Right Click," or "Left Click" to click the mouse buttons

n "Go to Sleep ," Stop Listening," or "Microphone Off" to turn the microphone off

To specify which mouse button (left, right, or center) is being held down during
mouse drags or if you want the SHIFT, CTRL, or ALT key held down during the mouse
drag, use one of these commands before saying one of the drag commands in the
preceding table:

For example, to drag with the Shiftkey held down, you could say "Shift Mouse Drag
Up." To drag with the right Alt key held down (the alt key on the right side of the
keyboard), you could say "Right Alt Drag Mouse Upper Left."
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You can use Dragon to select and correct and edit text that you dictate.

Correcting and editing 64
Correcting mistakes 64
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Deleting text 73
Spelling as you Dictate 75
Playing back your Dictation 76
Using text-to-speech 79
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Correcting and editing
When Dragon NaturallySpeaking or Dragon Medical types the wrong words, you
should correct these mistakes. By giving the program the right word, you actually
teach the program not to make the same mistakes again.

Correcting mistakes requires some extra effort, but it saves you time in the long run
by making Dragon more accurate. You'll probably need to correct mistakes often
when you first start dictating, and then less frequently as the program learns from
your corrections.

Make it a habit to correct mistakes to continue to improve the accuracy of the
program. Make sure you save your speech files when prompted, to preserve the
adjustments the programmakes.

Notes:

n You must select a word before typing over it. Using the backspace key and retyping (or

saying "Scratch That") will not enable the software to learn from corrections and improve

recognition accuracy. For accuracy to improve, you must first select text and then correct it

or overwrite it with the words you said.

n You cannot apply "Scratch That" to a selection that is larger than 299 characters.

n You cannot select by voice a block of text that is larger than 299 characters.

Correcting mistakes
There are a number of ways you can correct the misrecognitions in a document. The
following techniques describe the most basic methods, but you can combine these
techniques in any manner that suits your working style.

To correct text with the keyboard

1. Move the insertion point to the beginning of the dictation you want to correct.
2. Press the correction hot key to display the Correction menu. By default, this is the
minus (-) key on the numeric keypad. You can change the hot key assignment on
the Hot keys tab of the Options dialog box. You can also click the Correction but-
ton on the Extras toolbar of the DragonBar.

3. If one of the alternatives is correct, press the Down Arrow key to highlight that
choice and then press Enterto accept it. If no alternative is correct, just type or
say the correct text.

4. Continue until all the text is correct.

Correcting text using voice commands

1. Say "Select" or "Correct" and the text that is incorrect, the Correction menu
appears with a number of alternatives.

2. If one alternative is correct, say "Choose" and the number of that alternative.
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3. If none of the alternatives is correct, say "Spell That," spell the correct word or
words into the Spell dialog box, and then say "OK."
Selecting a large amount of text or an entire document and then saying "Spell
That" can produce unpredictable results.

4. Verify that the correct text appears in the document in place of the misrecognized
text and continue to the next incorrect recognition.

Correcting text while playing back dictation

1. Move the insertion point to the beginning of the dictation you want to correct.
2. Click Play That Back on the Sound menu of the DragonBar or click the Start Play-
back button on the Extras toolbar. You can also say, "Play that back."

3. When the playback of your dictation reaches a recognition error, press the cor-
rection hot key. By default, this is the minus (-) key on the numeric keypad.

4. If one of the alternatives is correct, press the Down Arrow key to highlight that
choice and then press Enter to accept it. If no alternative is correct, just type or
say the correct text and press the Correction hot key again. Playback continues
automatically from the point where you stopped.

5. Continue until all the text is correct.

Using the Correction Menu
The Correction menu shows Dragon's best guess of the alternatives to the words
you dictated and selected. In the following example, Dragon heard the word "quick"
as "clinic."
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You choose the correct word from the Correction menu by saying "Choose" and the
number next to your choice.

Note: You can change the number of choices displayed for you. In the Options
dialog box, click the Correction tab and increase the number in Show no more than n
choices. If you want to display your choices without the Correction menu taking up
too much space on the screen, select the Show only the choices option. See the
online help for more information.

When the Correction menu list appears, you can also choose to:

n Spell the word (for example, say "Spell That q-u-i-c-k"). Selecting a large amount of text and

then saying "Spell That" can produce unpredictable results.

n Press the correction hot key (-) while the Correction menu is open will display the Spell

dialog box.

n Listen to a recording of what you just said (say "Play That Back").

n Capitalize it (say "Cap That," in this example, to get "Clinic")

n Say "Unselect That" to cancel the selection and close (dismiss) the Correction menu

n Ignore the Correction list and keep dictating (in the example above, just say "quick" to

replace the selected text)

Note: If you prefer not to see the Correction menu every time you select text by
voice, you can turn it off. In the Options dialog box, click the Correction tab to
display the Correction options, then clear the check box for `Select' commands
bring up Correction menu.

To help you quickly find the alternative you want, the recognition choices in the
Correction menu appear in boldface where they differ from the word you've selected
(applicable only when you select multiple word at one time).
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If you select any leading or trailing spaces (including paragraph marks) along with
the text you want to correct, choosing one of the alternatives in the Correction
menu deletes those leading and trailing spaces.

Correcting punctuation
Note the following when correcting punctuation:

n When you select a phrase (more than one word) that has punctuation, be sure to dictate

that punctuation. For example, say you initially dictated, "Today is Thursday I have a meeting at

11 o'clock" and the text was transcribed as "Today is Thursday, I have a meeting at 11 o'clock". If

you want to change the comma to a period, say "Select Thursday comma". If the correct

punctuation appears in the Correction menu, select it. Otherwise, you can dictate over the

selection by, for example, saying "Thursday period."

n When you select punctuation, the Correction menu might list alternate punctuation (see

example to the right)
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n If Natural Punctuation is turned on, when you select a phrase that Dragon has added

punctuation to, the choices will include punctuation changes (see example here).

Note: When you select a word that has adjacent punctuation the Natural
Punctuation feature added, the selection will extend to include that punctuation.

Selecting text by voice
Using Full Text Control

You can revise your dictation without correcting it by selecting the text using the
"Select" command and then saying new words to replace the selected text.

To use Full Text Control

Dictate the sentence below:

US/Canada: "Let's meet for lunch on Tuesday [period]"

Other Dialects: "Let's meet for lunch on Tuesday [full stop]"

1. Say "Select lunch on Tuesday." The words lunch on Tuesday should be high-
lighted on the screen.

2. Say "dinner on Wednesday." These words should replace lunch on Tuesday.
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Since "Tuesday" and "Wednesday" sound completely different, Dragon will know
you are not correcting a recognition mistake but rather revising your dictated text.

1. Say: "Select period" (US/Canada) or "Select full stop" (Other Dialects). If there's
more than one period or full stop, you can say "Select Again" to select a different
one.

2. To replace the period or full stop with an exclamation mark, say "exclamation
mark."

Notes:

n It is often easier for Dragon to find the matching text if you select a short phrase rather

than individual words. If you select some words that are already correct, just say them again

along with the ones you want to change.

n You can also select punctuation marks.

Selecting the same text again

If the words you're trying to select appear more than once on the screen and
Dragon selects the wrong ones, just say "Select Again". The program then looks for
another instance of the same word or words.

You can also say "Select Again" if Dragon selects a word that sounds like the word
you want, but is not the correct one (for example, "two" instead of "too").

Unselecting words

If the wrong text is selected, say "Unselect That."

You can also unselect words by moving your insertion point (by mouse or voice) to
another part of your document. For example, say "Go to End of Line" or click
somewhere else in your document.

Selecting a longer phrase

You can select a longer phrase by saying "Select [text] Through [text]"
(US/Canada) or "Select[text] To [text]" (Other Dialects). For [text], substitute the
actual word or words at the beginning and the end of the range of wrong words. For
example, you could correct the underlined words in the following sentence:

With a little practice, who will develop a habit of dictating an unclear, steady voice,
and the computer will understand you better.

by saying:

(US/Canada) "Select who Through unclear" or "Select who will Through an unclear"

(Other Dialects) "Select who To unclear" or "Select who will To an unclear"

Then dictate the correct text:

"you will develop the habit of dictating in a clear "

The final corrected sentence reads:
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With a little practice, you will develop the habit of dictating in a clear, steady voice,
and the computer will understand you better.

Note: If you're correcting more than one word, the words must all be in sequence
(next to each other). You can't use a single command to correct words that are in
different parts of your document.

Selecting your whole document

To select all the text in your document, say "Select Document" or "Select All". This
command is useful when you want to change the font or the way text is aligned.

When you want to copy all the text in a document to another window, the easiest
way to do it is with the "Copy All to Clipboard" command.

Note: When a lot of text is selected, the "Scratch That" and "Cut That" commands
don't work, nor can you overwrite the selection by dictating new text. This prevents
you from accidentally deleting a large part of your document. To remove a large
selection, you can say "Delete That" instead.

Selecting an entire paragraph or line

You can select the current paragraph by saying "Select Paragraph". To select the
current line, say "Select Line."

You can also select a number of paragraphs or lines (up to 20). For example, you
can say "Select Previous 5 Paragraphs."

Say Then say Then say

Select Next Paragraph

Previous 2...20 Paragraphs

Forward Line

Back 2.20 Lines

Last

Selecting a word or character

You can select the current word by saying "Select Word". To select a character, say
"Select Next Character" or "Select Previous Character."

You can also select a number of words or characters (up to 20). For example, say
"Select Previous 2 Words."

Say Then say Then say
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Select Next Word

Previous 2...20Words

Forward Character

Back 2...20 Characters

Last

Moving around in a document

When you're editing a document, you can move around in it by voice. After you
place the insertion point where you want it, you can dictate more text, select text,
copy and paste, or apply formatting.

Going to the top or bottom of a page or document

You can move to the top or bottom of the current page by saying "Page Up"
(equivalent to pressing the Page Upkey) or "Page Down" (equivalent to pressing
the Page Downkey).

You can move to the top or bottom of your document by saying "Go to Top" or "Go
to Bottom."

Say Then say

Go to Top

Move to Bottom

Top of Document

Beginning of Document

Start of Document

Bottom of Document

End of Document

Going to the beginning or end of a line

You can move to the beginning or end of the current line by saying "Go to Beginning
of Line" or "Go to End of Line."

Say Then say

Go to Beginning of Line

Move to Start of Line

End of Line
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Placing the insertion point before or after a specific word

You can place the insertion point before a specific word by saying "Insert Before"
and then the word or words. You can place the insertion point after a word by saying
"Insert After" and then the word or words.

After you move the insertion point where you want it, you can dictate more text,
paste text, add punctuation, and so on.

To place the insertion point before a specific word

To move the insertion point before the word lets in the sentence below, say "Insert
Before lets" (or "Insert Before lets me talk"). Remember not to pause between any
of the words:

Dragon lets me talk instead of type.

To place the insertion point after a specific word

To move the insertion point after the word "talk" in the sentence below, say "Insert
After talk" (or "Insert After lets me talk").

Dragon lets me talk instead of type.

Moving up or down a paragraph or line

You can move up or down a paragraph by saying "Move Up a Paragraph" or "Move
Down a Paragraph." You can also move up and down a number of paragraphs (up to
20). For example, you can say "Move Up 3 Paragraphs".

You can move up or down a line by saying "Move Up a Line" or "Move Down a Line".
You can also move up and down a number of lines (up to 20). For example, you can
say "Move Down 3 Lines," as delineated in the table below:

Say Then say Then say

Move Up a Paragraph or 1
Paragraph

Back 2...20 Paragraphs

Down a Line or 1 Line

Forward 2...20 Lines

Moving right or left a word or character

You can move to the right or left of a word by saying "Move Right a Word" or "Move
Left a Word". You can also move right or left a number of words (up to 20). For
example, you can say "Move Right 3 Words."

You can move to the next or previous character by saying "Move Right a Character"
or "Move Left a Character". You can also move forward and backward a number of
characters (up to 20). For example, you can say "Move Left 4 Characters" or "Move
Back 6 Characters," as delineated in the next table:
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Say Then say Then say

Move Right a Word or 1 Word

Forward 2...20Words

Left a Character or 1 Character

Back 2...20 Characters

Copying, cutting, and pasting text
You can move text from one place to another by using the "Copy That," "Cut That,"
and "Paste That" commands.

To copy, cut, or paste text

1. Select the text you want to copy or cut.
2. Say "Copy That" or "Cut That. "
3. Move the insertion point to where you want to paste the text.
4. Say "Paste That."

Deleting text
Deleting the last words you dictate

You can erase the last words you dictated by saying "Scratch That". When you say
this command, Dragon deletes the last thing it typed into your document. This may
be a full sentence, a phrase, or just one word, if that's all you said before pausing.

You can say "Scratch That" up to 10 times to delete the last few things you said. If
you repeat the command, you must pause before saying it again. You can also say,
for example, "Scratch That 5 Times".

You cannot apply "Scratch That" to a selection that is larger than 299 characters.

Going back as you dictate

When you're dictating, sometimes you may hesitate or think of a better way to say
something right after you've said it. When this happens, you can use the "Resume
With" command to return to where you were before the mistake.

Just say "Resume With" followed immediately by the word or words to which you
want to return. Then, continue dictating. Any text after the new position of the
insertion point will be replaced with your new dictation.

73



Dragon Medical 360 | Network Edition User Guide

Note: When using the "Resume With" command, remember not to pause in the
middle. Say "Resume With" and then immediately say the words to which you want
to return. These words must be in the last three or four sentences (100 characters)
you said; you can't use "Resume With" to return to an earlier part of your
document.

To go back as you dictate

1. Suppose you dictate this sentence: "I have a deadline this week, but we could
meet for lunch... um... er... next Wednesday".

2. To correct the sentence, return to the last correct words you remember dictating.
For example, say "Resume With meet for lunch". (Remember not to pause in the
middle.)

3. Then, dictate the rest of the sentence. For example, say "next Wednesday at
noon".

Deleting specific words

You can delete text by selecting it and saying "Delete That".

To delete text

1. Select the text you want to delete.
2. Say "Delete That".

Deleting the next or previous paragraph or line

You can delete the next or previous paragraph by saying "Delete Next Paragraph" or
"Delete Previous Paragraph". You can delete the next or previous line by saying
"Delete Next Line" or "Delete Previous Line".

You can also delete a number of paragraphs or lines (up to 20). For example, you
can say "Delete Previous 5 Paragraphs". See the complete list below:

Say Then say Then say

Delete Next Paragraph

Previous 2...20 Paragraphs

Forward Line

Back 2...20 Lines

Last

Deleting the next or previous word or character

You can delete the next or previous word by saying "Delete Next Word" or "Delete
Previous Word". You can delete the next or previous character by saying "Delete
Next Character" or "Delete Previous Character".
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You can also delete a number of words or characters (up to 20). For example, you
can say "Delete Previous 5 Words". See the complete list below:

Say
Then
say Then say

Delete Next Word

Forward 2...20Words

Previous Character

Back 2...20 Characters

Last 2...20 Characters

Note: Another way to delete the previous character is by saying "Backspace". This
is equivalent to pressing the BACKSPACE key. You can "press" it multiple times (up
to 20) by saying, for example, "Backspace 5."

Spelling as you Dictate
With the Spell command in Dragon, you can easily spell a word or phrase you want
to dictate into your document. This can be useful if you are dictating a word that is
not likely to be in the Dragon vocabulary, such as a proprietary term, a proper
name, or a non-English word. Say, for example, "Spell b-u-o-n space g-i-o-r-n-o."
The word you spelled appears right in your document.

You must say "Cap" if the word contains a capital letter. For example, say "Spell Cap
R-u-m-p-e-l-s-t-i-l-s-k-i-n" to type "Rumpelstilskin."

If you say "Spell" by itself, without any letters after it, the Spell dialog box opens.
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You can then speak the letters and Dragon will type them or you can correct any
errors in the word you spelled.

When spelling, you can say numbers and special characters as well as letters. For
example, to dictate an automobile license plate number, you could say "Spell y-h-
m-6-0-9." Dragon would type yhm609. Say "Spell Cap-m-a-c-m-i-l-l-a-n-
trademark" to get MacMillan? in your document.

Spelling a word adds that word to the active vocabulary. Words that contain
numbers are not added to the vocabulary.

Note: To dictate unusual text such as automobile license plate numbers or product
codes, you can also switch to Spell mode by saying "Switch To Spell Mode," and
then dictate letters.

You can make the Spell dialog box appear whenever you use the Spell command by
setting the "Spell" commands bring up the Spell dialog box option on the Correction
tab in the Options dialog box. See the online help for more information.

You can also access the Spell dialog box when using the Select or Correct
commands.

For a list of how to spell special characters, see the Spelling topic in the online
Help.

Playing back your Dictation
Playback commands work in the DragonPad, Microsoft Word 97, 2000, 2002 and
2003, Corel WordPerfect 8 and 9, and Lotus Notes.

Although Dragon never makes a spelling mistake, the mistakes it does make can be
challenging to find and fix. Sometimes, what the program types looks very different
from what you actually said.

To make correcting mistakes easier, Dragon records your voice as you dictate. You
can play back your voice whenever you cannot tell by looking at your document
what you originally said.

Note: Unless you have Dragon Professional or a higher edition, playback is
available only until you close a document. After you close a document, Dragon
deletes the recorded dictation for that document. See Dictate now, correct later
in this chapter for information on saving dictation for later correction (Professional
and higher editions).

Playing back dictation from the Correction menu

When you're working in the Correction menu, click the Play Back button or say "Play
That Back" to play the dictation that goes with the words you're correcting. Then
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edit the text to match what you said.

Sometimes, there's no dictation to play back. For example, you cannot play back
text that wasn't entered by voice, such as words you typed or pasted into your
document.

Note: Even when you have entered text by voice, you cannot play it back after you
have cut it, copied it, pasted it, or otherwise moved it around in the document.

If you have Dragon Naturally Speaking Professional or Medical or a higher edition,
you can save your dictation with your document for later playback (see See Dictate
now, correct later in this chapter). Otherwise, you cannot play back dictation after
closing a document.

If dictation is not available, the Play Back button is dimmed (grayed out). When
playback is not available, you may find text-to-speech useful for checking your
work. .

Playing back dictation in a document

To help you check your work for mistakes, you can play back a line, a paragraph, a
selection, or the whole document. After playback starts, you can stop it as soon as
you notice a mistake and automatically open the Correction menu.

The Playback toolbar is an extra section of the DragonBar that is normally hidden.
To see the Playback toolbar, click the double chevron icon on the DragonBar to
open the Extras toolbar.

To play back dictation

To play back dictation, do any of the following:

n Select the text you want to play back, and say "Play That Back ."

n Click the Start Playback button on the Playback toolbar.

n Move the insertion point to the text you want to play back and say any of the following

commands:

77



Dragon Medical 360 | Network Edition User Guide

Say To

Play Back Line Play back dictation for the current line.

Play Back
Paragraph

Play back dictation for the current paragraph.

Play Back
Document

Play back dictation for the whole document.

Play Back
Window

Play back dictation for the text in view.

Play Back to Here Play back dictation from the top of the
document window to the insertion point.

Play Back from
Here

Play back dictation from the insertion point to
the bottom of the document window.

To stop playback

To stop playback, do any of the following:

n Click the Stop Playback button on the Playback toolbar.

n Click anywhere in the document window.

n Press the ESC key.

(It's not possible to stop playback by voice, because the computer cannot hear
speech input when it is playing back dictation.)

To skip backward or forward

You can skip backward or forward in your document by a few words by clicking the
Skip Backward and Skip Forward buttons.

To stop playback and correct a mistake

To stop playback and correct a mistake, do any of the following:

n Click the Correction button on the Playback toolbar.

n Press the minus (-) key on the numeric keypad.

This stops playback and simultaneously opens the Correction menu. There you can
correct the text for the last phrase played back.

Dictate now, Correct later

When you dictate into the DragonPad, you can save your dictation with your text so
either you or someone else can correct it later. You must create and edit your file in
the DragonPad to be able to play back dictation. This feature is available in Dragon
Professional, Medical, and higher editions.

You can save dictation with your document if you select the Save recorded dictation
with document box on the Data tab of the Options dialog. The first time you save a
document in DragonPad during an editing session, Dragon asks you whether you
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want to save your speech data. If you save your speech data, you can reopen the
document at a later time and play back your dictation. If you do not save your
speech data, your dictation is stored only during the current editing session.

Correcting your own dictation

If you save your dictation, you can open your file later and play back and correct the
text as if you had just dictated it.

Using text-to-speech
You can use text-to-speech to have text displaying on your screen (not your current
dictation) read aloud in a computer voice. You can use this feature to have the
product read back a document that you (or someone else) dictated while you listen
for mistakes and make note of sections you might want to revise.

Text-to-speech is available only in the DragonPad, Microsoft Word, and Corel
WordPerfect. You can, however, copy and paste text from other programs and then
use text-to-speech.

To start text-to-speech

n Select the text you want to hear (a line, a paragraph, and so on), and then say "Read That."

n Select the text you want to hear, and then select Read That from the Advanced submenu

(or right-click in your document and click Read That from the shortcut menu).

n Move the insertion point to the text you want to hear and say any of the following

commands:

Say To

Read Line Read back the current line.

Read Paragraph Read back the current paragraph.

Read Document Read back the whole document.

Read Window Read back the text in view.

Read to Here Read back from the top of the document
window to the insertion point.

Read from Here Read back from the insertion point to the
bottom of the document window.

To stop text-to-speech

n From the NaturallySpeaking menu, point to Advanced and click Stop Playback/Reading.

n Right-click in your document and click Stop Playback/Reading from the shortcut menu.

n Press the ESC key.
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You can control the speed, pitch, volume, and other text-to-speech settings. From
the menu, click Tools > Options and select the Text-to-Speech tab.
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You can use your voice to tell Dragon how to format text. Formatting actions you
can perform include bolding text, changing font sizes and styles, and capitalizing
text.

Formatting with Dragon 82
Types of commands 82
Capitalizing text 82
Formatting text 84
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Formatting with Dragon
You can bold text, change font sizes and styles, capitalize text, and apply other
formatting by voice.

Many Dragon NaturallySpeaking or Dragon Medical formatting commands work for
text that is selected (highlighted) in your document. To select text by voice, say
"Select" plus the words you want to select. You cannot select by voice a block of
text that is larger than 299 characters.

See Selecting text by voice in Correcting and editing for information.

Types of commands
Most of the commands listed in this chapter are global--they are available in
virtually every application. In addition to the global commands listed here, Dragon
includes many commands for editing and formatting that work in common
applications. For more information on finding these commands see the Dragon
online help.

Note: You can change the formatting properties of a word (such as whether Dragon
should type a space before or after the word, or whether the word is capitalized in a
title) by using the Word Properties dialog box. See the online help for more
information.

Capitalizing text
Capitalizing the first letter of the next word you dictate

Dragon capitalizes many words automatically, such as the first word in a sentence
(following a period, question mark, or exclamation mark). It capitalizes the first
word after you say "New Paragraph" (not when you say "New Line") and it
capitalizes proper names (when these words are already in the Dragon vocabulary
in capitalized form).

Note: You can change the spacing and capitalization rules for a word in the Word
Properties dialog box. See the online help for more information.

When you're dictating, you can capitalize words that aren't automatically
capitalized by saying "Cap" and then the word. For example, say "Cap zelda" to get
Zelda.

Note: If saying "Cap <word>" doesn't work, try say "Cap Next <word>."
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To dictate the word "cap," for example, in this sentence: The company is putting a
cap on salary increases, you must say "the company is putting a" then say "Spell c-
a-p," and then say "on salary increases." In this way, Dragon knows that you do not
want to capitalize any of the words within the sentence.

Capitalizing consecutive words

When you want to capitalize consecutive words (for example, if you're dictating a
book title), you can turn capitals on and then turn them off when you're finished.
This is usually easier than saying "Cap" before each word. Another way to do
consecutive capitalization is to dictate the words, pause, and then say "Capitalize
That" or "Cap That."

To capitalize the first letters of consecutive words

1. Say "Caps On" to turn capitals on
When "Caps On" is active, Dragon uses title case. This means it capitalizes the
first letters all words except for articles and prepositions (such as "the" and
"to")..

2. Dictate the words you want capitalized. For example, say: "success is a journey
[colon] seven steps to achieving success in the business of life"

Dragon types:
Success Is a Journey: Seven Steps to Achieving Success in the Business of Life

3. Say "Caps Off" to turn capitals off

 Capitalizing names of people, departments, and drugs in Medical Edition

Your administrator can set Auto-Formatting options that tell Dragon that you want
either initial caps or all caps for names of people, departments, and medications.
Contact your administrator for more information.

Capitalizing critical words for emphasis in Medical Edition

Your administrator can set Auto-Formatting options that tell Dragon you want words
such as ALLERGY or CODE BLUE or DO NOT INTUBATE to be in all caps for emphasis.
Contact your administrator for more information.

Dictating next word in all capital letters

When you're dictating, you can enter a word in all capital letters by saying "All
Caps" and then the word.

For example, say "All Caps please" to get PLEASE.

In the Medical Edition, you can choose to have important words appear in all caps
automatically. See Capitalizing critical words for emphasis in Medical
Edition in this chapter for more information.

Dictating consecutive words in all capital letters

When you want to dictate consecutive words in all capitals, you can turn all capitals
on and then turn them off when you've finished.
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To dictate consecutive words in all capitals

1. Say "All Caps On" to turn all capitals on (like pressing the CAPS LOCKkey).
2. Dictate the words that you want to appear in all caps. For example, say "the end"
and Dragon types THE END

3. Say "All Caps Off" to turn all capitals off

Dictating next word in all lowercase letters

When you're dictating, you can enter a word in all lowercase letters by saying "No
Caps" and then the word.

For example, say "No Caps Jennifer" to get jennifer. (Dragon normally capitalizes
this and other proper names.)

Dictating consecutive words in all lowercase letters

When you want to dictate consecutive words in lowercase letters (for example,
names of computer files or e-mail addresses), you can turn the "no capitals" feature
on and then turn it off when you are finished. This is usually easier than saying "No
Caps" before each word.

To dictate consecutive words in all lowercase letters

1. Say "No Caps On" to turn no capitals on
2. Dictate the words you want to appear in all lowercase.
3. Say "No Caps Off" to turn no capitals off.

Capitalizing or uncapitalizing text already in your document

You can change the capitalization of text already in your document by selecting it
and then saying "Capitalize That," "Cap That," or "All Caps That," or "Uncapitalize
That," "Uncap That," or "No Caps That."

To capitalize or uncapitalize text

1. Select the text you want to change.
2. Say "Capitalize That," "Cap That,"or "All Caps That," or "Uncapitalize That,"
"Uncap That,"or "No Caps That."

Formatting text
You can use voice commands to specify any combination of font name, size, and
style, in that order. These commands change text you dictate from then on or text
you have selected.

To set a new style for text you are about to dictate, use the "Set Font" and "Set
Size" commands. To change the style of text you have already selected, use the
"Format That" command.

Changing the font as you dictate

While dictating, you can change the font face, size, and style by saying "Set Font"
followed by the font attributes you want. For example, you can say "Set Font Times"
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or "Set Font Arial 12 Bold."When you continue dictating, the new text appears with
the font attributes you set.

Changing the font face

Say Then say

Set Font Arial

Courier

Courier New

Garamond

Helvetica

Palatino

Times

Times New Roman

Changing the font size

"Set Size" and then a size from 4 to 100 points. For example, say "Set Size 18."
Then, continue dictating.

Changing the font style

Say Then say

Set Font Bold

Italics

Bold Italics

Underline

Strikeout

Plain or Plain Text or Normal or Regular

Changing a combination of font face, size, and style

Say "Set Font" and then the attributes you want (listed in the previous sections).
You can specify any combination of font face, size, and style, but you must specify
these attributes in that order (font face, then size, then style). See the list of
examples below:

n "Set Font Arial"

n "Set Font Arial 12" or "Set Font Arial 12 Point"

n "Set Size 12 Bold"

n "Set Font Arial Bold"

n "Set Font Bold"
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Note: If you're changing only the font size, use the "Set Size" commands, not the
"Set Font" command.

Changing the font later

You can go back and change the font face, size, or style of text by selecting it and
then using the "Format That" commands. "Format That" works on selected text
with the same combinations of font face, size, and style as the "Set Font"
commands (see the tables in the previous section.)

To change the font

1. Select the text you want to change.
2. Say "Format That" and then the font attributes you want to apply as described in
the previous section. For example, say "Format that Arial 18."

Bold, italics, and underlining

You can apply formatting to text in your document by selecting it and then saying
"Bold That," "Italicize That," or "Underline That." You can also say "Strikeout
That."

To add bold, italics, and underlining

1. Select the text you want to change.
2. Say "Bold That," "Italicize That," "Underline That," or "Strikeout That."

To remove formatting

1. Select the text you want to change.
2. Say "Restore That" to remove formatting.

Aligning text

You can change how text is aligned by placing your insertion point in the text and
saying "Center That," "Left Align That," or "Right Align That."

To align text

1. Move the insertion point to the text you want to align.
2. Say "Center That," "Left Align That,"or "Right Align That."

You can also use the following commands on selected text: "Format That Centered,"
"Format That Left Aligned," and "Format That Right Aligned."

Bulleted text

To add bullets to text, place your insertion point in the text and say "Format that
Bullet Style." To remove bullets, say "Format that Bullet Style" again.
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This chapter describes how to dictate numbers, punctuation, Web addresses, and a
few other special items. For complete information on this topic, see the online help.
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Dictating Numbers and Punctuation
This chapter describes how to dictate numbers, punctuation, Web addresses, and a
few other special items. For complete information on this topic, see the online help.

Note: If Dragon is not formatting a word as you would like, you can change the
formatting properties of the word by using the Word Properties dialog box. See the
online help for more information.

Dictating numbers
In most cases you can dictate numbers, including postal codes, as you normally say
them. Dragon will display either a numeral ("3") or the word ("three"), based on the
context. To force recognition of digits as numerals instead of text without using the
Numbers Mode, say "Numeral"before you say the digit, for example, say "Numeral
Three" to get 3. When dictating numbers:

n You can use or omit the word and as part of a number. For example, say "one hundred fifty"

instead of "one hundred and fifty" to get the number 150.

n You can use "oh" and "zero" interchangeably to get 0.

n If you want a comma in a four-digit number, you must speak it explicitly. Numbers with

five or more digits automatically include commas, with the exception of US ZIP codes.

n For a decimal point, say "point."

Note: If you want to dictate only numbers, you can switch to "Numbers Mode."

See Switching recognition modes in Dictating Special Characters for more
information.

To enter Say

1 one

numeral one

5 five

numeral five

17 seventeen

23 twenty three

179 one hundred seventy nine
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To enter Say

one seventy nine

5423 five thousand four hundred and twenty three

5,423 five [comma] four twenty three

12,537 twelve thousand five hundred and thirty
seven

142,015 one hundred and forty two thousand and
fifteen

35.23 thirty five [point] two three

0.03 All Dialects: zero [point] zero three

Outside US/Canada: nought [point] nought
three

43.28% forty three [point] twenty eight [percent
sign]

02460 oh two four six zero

02460-1458 oh two four six zero [hyphen] one four five
eight

2 3/4 two and three fourths

11/32 eleven over thirty two

$99.50 ninety nine dollars and fifty cents

45.35 45 Euros and thirty-five cents

£120.35 pound sterling sign one hundred and twenty
point thirty five [All Dialects]

Note: If you are having problems dictating numbers, currency, times, or dates,
make sure that your Regional Settings match the language (dialect) for your user
profile.

Numbers mode

Any time you need to dictate a series of numbers and do not want Dragon to
recognize them as words, you can turn on Numbers Mode. This could be useful, for
example, if you are dictating in a spreadsheet program, such as Microsoft® Excel®.
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To turn on Numbers Mode, say "Start Numbers Mode" or "Numbers Mode On." To
turn off Numbers Mode, say, "Stop Numbers Mode" or "Numbers Mode Off" or
"Switch to Normal Mode."

For more information on Numbers Mode and more ways to turn Numbers Mode on
and off, see the section Switching recognition modes in Dictating Special
Characters for more information.

Dates

You can dictate most dates the way you would normally say them. Say "oh" or
"zero" to enter 0. In dialects other than US/Canada, you can also say "nought."

To enter Say

22 January
1999

twenty two January nineteen ninety nine

April 9, 2001 April 9 [comma] two thousand and one

14/07/85 fourteen [slash] oh seven [slash] eighty five

3/11/02 three [slash] eleven [slash] zero two

3/11/2002 three [slash] eleven [slash] two thousand and two

April 1st April first

March 22nd March twenty second

the 1980s the nineteen eighties

See Automatic formatting of dates, times, telephone numbers in this
chapter.

Times of day

Dictate the time of day the way you would normally say it.

US/Canada: Dragon automatically types the colon (:) if you say "a m" or "p m"
when dictating the time. Say "o'clock" or "colon zero zero" to enter 00.

To enter Say

8:30 eight [colon] thirty or eight [numeric colon]
thirty

7:45 AM seven forty five a m

10:22 PM ten twenty two p m

3:00 three o'clock or three [colon] zero zero

5:00 PM five o'clock p m
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Note: Dragon will recognize times more accurately if you say "numeric colon"
instead of "colon" when dictating times.

Other Dialects: Dragon automatically types the point (.) if you say "a m"or "p
m"when dictating the time, depending on the regional setting. Say "o'clock" or
"point zero zero" to enter .00.

To enter Say

8.30 eight [point] thirty

7.45 AM seven forty five a m

10.22 PM ten twenty two p m

3.00 three o'clock

5.00 PM five o'clock p m

Note: The format of "a.m." and "p.m." depends on your computer's regional
Windows® settings.

See Automatic formatting of dates, times, telephone numbers in this
chapter.

Telephone numbers
North American phone numbers

Say US and Canadian phone numbers as you normally would, pausing briefly
between each group of numbers.

You don't need to dictate hyphens for most phone numbers (numbers that are 7, 10,
or 11 digits long). Dragon will add them automatically.

To enter Say

965-5200 nine six five fifty two hundred

617-965-5200 six one seven nine six five fifty two oh oh

1-800-555-1212 one eight hundred five five five one two one
two

(617) 965-5200 [open parenthesis] six one seven [close
parenthesis] nine six five five two zero zero

1-212-555-1212 one two one two five five five one two one
two
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Telephone numbers outside North America

To dictate other phone numbers, including European phone numbers, you must say
all the punctuation, including the hyphens, spaces, and parentheses.

To enter Say

(01628) 894150 [open parenthesis] oh one six two eight
[close parenthesis] eight nine four one five
oh

027 629 8944 oh two seven [space bar] six two nine [space
bar] eight nine four four

61-7-4695-2055 six one [hyphen] seven [hyphen] four six
nine five [hyphen] two zero five five

(65) 2778590 [open parenthesis] six five [close
parenthesis] two seven seven eight five nine
zero

Note: In dialects other than US/Canada, you can say "bracket" instead of
"parenthesis."

See Automatic formatting of dates, times, telephone numbers in this
chapter.

Automatic formatting of dates, times, and telephone numbers

To indicate how you want dates, times, telephone numbers, and other numbers
automatically formatted:

1. On the DragonBar, select Tools > Formatting. The Formatting dialog box appears.
2. If you have the Medical Edition, click the General tab.
3. Click the check box labeled Format dates and select the format you want from its
drop-down list. For instance, select Month D, YYYY or D/M/YY.

4. Click the check box labeled Format times. Dragon then formats times based on
your Regional Settings in Windows.

5. To have hyphens added to a phone number automatically, click the check box
labeled Format phone numbers (Medical) or Phone numbers (all other editions).

6. You can also click check boxes for Format other numbers (Medical only) and
Prefer 5 million over 5,000,000.

7. Other formats you can click check boxes for on this tab include United Kingdom
and Canadian postal codes and several non-numeric formats that involve using
common abbreviations, expanded contractions, abbreviations of units of measure
and titles (such as Mr., Ms., Dr.), and formats for web and email addresses as well
as street addresses.
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8. If you have any edition other than Dragon Medical, click OK to save the settings
and close the dialog box.

An administrator can set more advanced formatting settings. Contact your
administrator for more information.

Fractions

You can dictate most common fractions the way you would normally say them. To
dictate 1/2, 1/3, 1/4, 1/5, 1/6, 1/7, 1/8, 1/9, 1/10, and 1/16 or a multiple of these
fractions, just say the fraction normally.

To enter Say

1/2 one half

1/4 one fourth orone quarter

15/16 fifteen sixteenths orfifteen over sixteen

3 7/8 three and seven eighths orthree and seven
over eight

If the denominator (bottom number in the fraction) is greater than 10, you can enter
the fraction by saying "slash" or "over" between the two numbers.

To enter Say

9/12 nine [slash] twelve ornine over twelve

5 3/56 five [space bar] three [slash] fifty six

130/70 one thirty over seventy

A few common fractions can also be displayed on your computer as special
characters (such as , , or ) instead of two numbers separated by a slash character
(such as 1/4, 1/2, or 3/4). For information about dictating fraction characters, see
Dictating uncommon special characters in Dictating Special Characters for
more information.

Ordinal numerals in Medical Edition

Your administrator can set formatting settings to have Dragon Medical format first
as 1st, second as 2nd, and third as 3rd, and so on. Contact your administrator for
more information.

Roman numerals

You can dictate Roman numerals by saying "Roman numeral" and the number. For
large numbers, say the number in small combinations (as in the examples shown
here).
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To enter Say

I Roman Numeral one

IV Roman Numeral four

V Roman Numeral five

X Roman Numeral ten

L Roman Numeral fifty

C Roman Numeral one hundred

D Roman Numeral five hundred

M Roman Numeral one thousand

XXIV Roman Numeral twenty our

XXXI Roman Numeral thirty one

MCMXCVII Roman Numeral one thousand

Roman Numeral nine hundred

Roman Numeral ninety

Roman Numeral seven

Note: Don't pause after the word "Roman Numeral" when you're dictating a Roman
numeral. If you pause, Dragon may enter, for example, "Roman numeral three"
instead of "III."

Roman Numerals in Medical Edition

Your administrator can set formatting settings to have Dragon Medical use Roman
numerals for types of diabetes (Type I, Type II). Contact your administrator for
more information.

Postal and ZIP Codes

Dragon can automatically formats postal codes. This feature is controlled from the
Formatting tab of the Options dialog box. For more information, see the online help.

US ZIP Codes

You can dictate US five-digit ZIP codes just as you dictate any group of numbers.
When dictating nine-digit ZIP codes, you must say the hyphen.

To enter Say

01886 oh one eight eight six

94704-1150 nine four seven oh four [hyphen] one one
five oh
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UK and Canadian Postal Codes

You can dictate UK postcodes by saying "Postcode"f ollowed by the letters and
numbers that make up the postcode. For Canadian postal codes, say "Postal code"
followed by the letters and numbers that make up the postal code. Spacing and
formatting will happen automatically.

To enter Say

NG3 2HX Postcode n g three two h x

E10 7BD Postcode e ten seven b d

EC2Y 4LK Postcode e c two y four l k

K1A 0M5 Postal code k one a zero m five

X0A 0H0 Postal code x oh a oh h oh

To indicate that you want United Kingdom and Canadian postal codes formatted
automatically in Dragon Medical, refer to Automatic formatting of dates, times,
telephone numbers in this chapter.

Currency and coin

You dictate your own currency as you would normally say it.

Currency in US.Canada (US English dialect)

To enter Say

$58.00 fifty eight dollars and zero cents

$1.75 one dollar and seventy five cents

$5.25 five dollars and twenty five cents

$3.9 billion three point nine billion dollars

45 forty five euros

99.50 ninety-nine euros and five cents

£ 2.20 pound sterling sign two point two oh

£ 5 million pound sterling sign five million
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Currency in Other Dialects (UK, Australian, Indian, and Southeast Asian English)

To enter Say

$58.00 dollar sign fifty eight

$1.75 dollar sign one point seventy five

4.25 four euros and twenty five cents

3.9 billion three point nine billion euros

£ 45 forty five pounds

£ 99.50 ninety nine pounds and fifty pence

£ 2.20 two pounds twenty

£ 5 million five million pounds

Note: Dragon uses the currency symbol ($, £, and so on) specified in your Windows
Regional Settings as your default currency.

Dictate other currencies by first saying the currency symbol followed by the digits.

US/Canada: If your Regional Settings are set to the United States or Canada, your
default currency is $ (dollar). If you want to dictate a dollar currency amount,
dictate it the way you normally do. If you want to dictate a pound sterling currency
amount, say, for example, "pound sterling sign fifty eight" (to enter £ 58), and so
on.

Note: In US/Canada, you must say "pound sterling sign" to enter £, since "pound
sign" means # in the U.S. vocabulary. In all other dialects, you can say "pound sign"
to type £.

Other Dialects:If your Regional Settings are set to the United Kingdom, your default
currency is £ (pound sterling). If you want to dictate a pound sterling currency
amount, dictate it the way you normally do. If you want to dictate a dollar currency
amount, say, for example, "dollar sign fifty eight" (to enter $58) and so on.

Note: Australian users can say "fifty eight dollars" to dictate $58, since the
Australian default currency is $ in Windows Regional Settings.
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Punctuation
Using Natural Punctuation

Dragon can automatically add commas and periods at the appropriate places in your
dictation without your having to explicitly speak that punctuation. This Natural
Punctuation feature can be useful in helping you get used to dictation by focusing on
what you are saying rather than how your speech is punctuated.

Natural Punctuation only inserts periods and commas. You still have to dictate other
punctuation marks. Even with Natural Punctuation turned on, you can still dictate
periods and commas. As you become more adept at dictation and want more control
over where punctuation appears, you may want to explicitly dictate all your
punctuation.

For information on correcting punctuation, see Correcting Punctuation in Correcting
and editing.

Note: Periods will only appear at the end of a sentence once you have started the
next utterance or said "New Line" or "New Paragraph."

Enabling and disabling automatic punctuation

Natural Punctuation is turned on by default.

There are two ways of turning Natural Punctuation on and off:

n Select Formatting from the Tools menu of the DragonBar and click Automatically add

commas and periods. In the Medical edition, this check box is under the General tab of the

Formatting dialog box.

n By saying "autopunctuation on" and "autopunctuation off." Turning Natural Punctuation on and

off by voice sets the option above in the Formatting dialog box. If you disable Natural

Punctuation by voice, it stays disabled until you enable it again.

Dictating Punctuation

You can enter the punctuation marks and symbols listed below in text you dictate.
For a list of all punctuation marks, see the online help.

To enter Say

, comma

. period

dot

point

[each one has different spacing
characteristics]
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To enter Say

? question mark

! exclamation mark (All Dialects)

exclamation point (US/Canada)

" open quote

close quote

` open single quote

close single quote

( open paren (US/Canada)

left paren (US/Canada)

left parenthesis (All Dialects)

open parenthesis (All Dialects)

) close paren (US/Canada)

right paren (US/Canada)

right parenthesis (All Dialects)

close parenthesis (All Dialects)

` apostrophe

`s apostrophe-ess

- hyphen

minus sign

-- [double hyphen] dash

space bar

You can use the Vocabulary Editor to view or change the formatting properties of
the punctuation.

Words that end with 's

To dictate a word ending with apostrophe S ('s), just say it as you normally would.
Dragon will often add it. If Dragon doesn't include the 's, you can add it later.

To enter Say

We took Mary's car We took Mary's car

that's enough that's enough

it's time to go it's time to go
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Including 's as you dictate

When you want to make sure that Dragon types a word with 's, say "apostrophe
ess" after saying the word. For words that already end in "s," say "apostrophe" after
the word, as in the second example shown here.

To enter Say

We took my
brother's car

We took my brother [apostrophe ess] car

I met my friends'
children

I met my friends [apostrophe] children

Note: You can add `s to a word by selecting it and then saying it again with
"apostrophe ess.

Dictating hyphenated words
Many hyphenated words and phrases are already in the Dragon vocabulary. To
dictate a word or phrase that is usually hyphenated, just say it as you normally
would.

To enter Say

long-lasting long lasting

up-to-date
schedule

up to date schedule

Tokyo-based
company

Tokyo based company

nine-year-old boy nine year old boy

Including hyphens as you dictate

To hyphenate words that Dragon doesn't hyphenate automatically, just say
"hyphen" wherever you want a hyphen.

To enter Say

speech-recognition
software

speech [hyphen] recognition software
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power-sharing
agreement

power [hyphen] sharing agreement

Elizabeth Walker-
Smith

Elizabeth Walker [hyphen] Smith

You can hyphenate words you just dictated with the command "Hyphenate That."
Select the words you want to hyphenate and say "Hyphenate That." If you say this
command when no words are selected, Dragon will usually hyphenate the last few
words that you said. You cannot select by voice a block of text that is larger than
299 characters.

Removing hyphens

You can remove a hyphen by selecting it and replacing it with a space.

To remove a hyphen

1. Say "Select hyphen."
2. Say "Space Bar."

Preventing hyphens

You can prevent Dragon from entering a hyphen by pausing where the hyphen would
normally be.

For example, to type "long lasting" (normally hyphenated) say "long," then pause
for a moment, and then say "lasting." Or you can say "long space bar lasting"
without pausing, to insert a space in place of the hyphen .

Hyphens and dashes in Medical Edition

Your administrator can set formatting settings to have Dragon Medical edition place
a hyphen between a number and the word French or place a hyphen between a
single digit and point when no other digit follows. Contact your administrator for
more information.

Dictating compound words
Dragon joins compound words (such as "note" and "book" to form "notebook")
automatically, based on standard usage. To dictate a compound word, just say it as
you normally would.

Compounding words as you dictate

To compound words that Dragon doesn't join automatically, just say "No Space"
between the words.

To enter Say

unitednations united [No Space] nations
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WorldWide Web [Cap] world [No Space] [Cap] wide [Cap] web

You can also dictate consecutive words without spaces by turning No spaces on and
then turning them off when you've finished.

To dictate consecutive words without spaces

1. Say "No Space On" to turn spaces off.
2. Dictate the words you want to appear without spaces.
3. Say "No Space Off" to turn spacing back on.

Compounding words later

You can compound the last words you said or compound selected words by saying
"Compound That." This command removes all spaces between selected words. Or,
if no words are selected, it removes all spaces in the last utterance. Any tabs or line
breaks are also removed.

To compound words

1. Select the text you want to join. For example, if you want to join the words "Web
TV," say "Select Web TV."

2. Say "Compound That."

Dictating names
Many names of people, places, and events are already in the Dragon vocabulary.
For example, you can dictate"Martin Luther King," "New York Times," and "Boston."

To dictate a name, first try dictating the name. Dragon automatically capitalizes the
names it knows. If Dragon incorrectly types the name, correct it by keyboard or by
voice (see Correcting and editing).

If the program continues to type a name incorrectly after you've corrected it several
times, train the word individually using the Train Word dialog box. See the online
help for more information.

Dictating abbreviations and acronyms
Dragon knows many common abbreviations (such as NYC and BBC) and acronyms
(such as NATO). To dictate an abbreviation or acronym, just say it as you normally
would.

To enter Say

US/Canada: Dr.

Other Dialects: Dr

Doctor

UK U K (say each letter)
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RSVP R S V P (say each letter)

HTML H T M L (say each letter)

8 cm eight centimeters

US/Canada: pp.
27-33

Other Dialects: pp
27-33

pages 27 hyphen 33

NATO NATO (say as one word)

NASDAQ NASDAQ (say as one word)

If Dragon types the full word instead of the abbreviation or acronym, enters the
wrong word, or includes incorrect punctuation, just correct it in your document by
voice or by keyboard.

Abbreviations and spelled-out words in Dragon Medical

Your administrator can set formatting settings to have Dragon Medical
automatically use special abbreviations or spell out words that would otherwise be
abbreviated or replaced by symbols but should not be in a medical context. Contact
your administrator for more information.

Dictating e-mail and Web addresses
Dictate e-mail and Web addresses as you would normally say them. Dragon
automatically formats them for you.

To enter Say

Virginia@aol.com Virginia at a o l dot com

info@samplecompany.com [No Caps On] info at sample company dot
com [No Caps Off]

http://www.nuance.com [No Caps On] h t t p w w w dot nuance dot
com [No Caps Off]

Here are some guidelines for dictating e-mail and Web addresses:

n When you say "h t t p"or "w w w," Dragon knows to format the next words you say as a Web

address.

n Say the following abbreviations by pronouncing them as words:

"co," "com," "gov," "mil," "net," and "org."

n Say the following abbreviations by saying each letter:

"a c," "b n," "c a," "e d u," "ie," "h k," "i d," "i n," "j p,"

"m y," "p h," "s g," "t h," and "u k."
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n Use the "No Caps On" and "No Caps Off" commands to enter an e-mail or Web address in

all lowercase letters. For more information about controlling capitalization, see Dictating

consecutive words in all lowercase letters in Formatting with Dragon.

Note: You can create Text and Graphics/auto-text custom commands for e-mail
and Web addresses you use often. See the online help for more information.

Dragon Medical can automatically format web and e-mail addresses as you dictate
them. For more on how to set up automatic formatting, see Automatic formatting
of dates, times, telephone numbers in this chapter.

103





Chapter 9: Dictating Special
Characters

This chapter describes how you can use your voice to dictate and work with special
characters.

Dictating Special Characters 106
Dictating uncommon special characters 107
Switching recognition modes 109
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Dictating Special Characters
The following special characters are in the Dragon vocabulary. To dictate these
characters, just say their names.

To enter Say

& ampersand or and sign

* asterisk

@ at sign

` backquote

© copyright sign

^ caret

° degree sign

$ dollar sign or dollar

euros or euro sign

% percent sign

® registered sign

§ section sign

? trademark sign

+ plus sign

- minus sign

« open euro quote

» close euro quote

# All Dialects: hash sign or sharp sign

US/Canada:number sign or pound sign

£ US/Canada: pound sterling sign

Other Dialects: pound sign or pound

:-) smiley face

:-( frowny face

;-) winky face

For complete lists of special characters, see the online Help.
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Dictating uncommon special characters
If you use uncommon special characters in your writing (for example, a double-
dagger sign ?), you can enter them by voice using the "Spell" command. If you use
a special character frequently, you can also add it as a new word using the
Vocabulary Editor.

For the complete list of special characters and their names, see the Special
Characters topic in the online Help.

To dictate a special character

Just say "Spell" plus the name of the character. For example, if you want to enter a
double-dagger sign (?) into your document, say "Spell double dagger."

To add a special character to the vocabulary

If you frequently want to dictate an unrecognized special character (for example,
double-dagger sign -- ?) into your document, you could add "double dagger" as a
new word to the Dragon vocabulary. Follow these steps:

1. In your document, dictate the phrase you want to use to enter the special char-
acter (for example, say "double dagger"). Dragon enters the words into your doc-
ument.

2. Say "Spell That" to open the Spell dialog box.
3. Say the name of the special character. (In this example, say "double dagger" to
enter the ?.)

4. Click or say "OK." Dragon types the special character (?) in your document and
adds it to your vocabulary.

5. To give a special character a spoken form, choose View/Edit from the Words
menu on the DragonBar. This action opens the Vocabulary Editor.

6. From the Display drop-down list at the bottom of the Vocabulary Editor, choose
CustomWords Only. You then see the special character you just entered under
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the Written form column, as shown in this illustration.

7. Click on the special character to select it. In the illustration above, the special
character is already selected.

8. In the Spoken form field, type the name you want to dictate for this character and
click Add.

9. Click Train. The Train Words dialog box opens.

10. Click Go and say the name of the character, as shown in the Train Words dialog
box. For example, say "double dagger."

11. Click Done to close the Train Words dialog box.
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12. The Vocabulary Editor might now have two words in the vocabulary with the same
written form. If one has a spoken form and one does not, click on the word that
does not have a spoken form and click Delete. This leaves the word that does
have a spoken form in your vocabulary. It is okay to have two spoken forms for a
single word or symbol, as you see here for the double dagger symbol. You can
have multiple alternative spoken forms for the same symbol that coexist in your
vocabulary.

13. Click Close to close the Vocabulary Editor.

Now when you dictate the character name (in this example, "double dagger"),
Dragon should enter the special character, not the words.

Notes:

n You can perform this operation more quickly by directly opening the Vocabulary Editor,

and directly adding the written and spoken form.

n You can change the formatting properties of a word (such as whether Dragon should type a

space before or after the word) by clicking Properties to open the Word Properties dialog

box. See the online help for more information.

Switching recognition modes
Dragon lets you use different recognition modes in your dictation. Dragon uses
normal mode by default. In normal mode, the program distinguishes between
words, numbers, and commands.

In addition to normal mode, there are other modes:

n Numbers mode--The software recognizes only numbers, commands, and punctuation. If

you are dictating only numbers (including currencies), working in this mode increases

recognition accuracy.

n Spell mode--The software recognizes only letters, numbers, commands, and punctuation.

In Spell mode, Dragon allows you to say any combination of letters, digits, or symbols you
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might need dictate part numbers or license plate numbers. You can also say keystrokes such

as space bar or backspace key. Spell mode is also useful for dictating internet or Web

addresses.

n Command mode--The software interprets everything you say as a command and nothing is

interpreted as dictated text.

n Dictation mode--The software interprets everything you say as dictation and nothing is

interpreted as a command, except for a few commands such as "New Line" and "New

Paragraph."

To change modes

1. Select the Words menu on the DragonBar and click the name of the mode you
want.

2. Switch modes by voice by saying one of these commands:

Mode To turn on, say To turn off, say

Numbers
mode

Numbers mode On or
Start Numbers Mode
or Switch to Numbers
mode

Numbers mode Off or
Stop Numbers mode
or Switch to Normal
mode

Spell
mode

Spell mode On or

Start Spell mode or
Switch to Spell mode

Spell Mode Off orStop
Spell Mode orSwitch
to Normal mode

Command
mode

Command mode On or
Start Command mode
or Switch to Command
mode

Command mode Off
or Stop Command
mode or Switch to
Normal mode

Dictation
mode

Dictation mode On or
Start Dictation mode
or Switch to Dictation
mode

Dictation mode Off
orStop Dictation
mode or Switch to
Normal mode

Turning a mode off by voice is the same as switching back to Normal mode.

Note: You cannot dictate fractions in Number mode.
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